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1.0 Applicable Standards / Regulations 
The Northeast Region of the National Oceanic and Atmospheric Administration (NOAA) National 
Marine Fisheries Service (Fisheries) Fishery Information Section (FIS) is responsible for collecting 
fisheries statistics including catch-effort, landings, economic data, stock monitoring, and biological 
samples associated with marine fisheries.  This manual provides the basic instructions or procedures 
for collecting and coding biological sampling information in preparation for data entry.   


2.0 Purpose 
Fish are primarily sampled to estimate length, age and species composition that assist in the 
characterization of the commercial catch.    The standard procedures are designed to assure the most 
representative sample is obtained under prevailing conditions.  It is, therefore, extremely important 
that there is no deviation from a procedure and that personal, or other selection bias, is minimized.  
(Biological Sampling Work Instructions(BSWI) 1.0 and 3.0) 


3.0 Scope 
Biological samples are gathered from federally permitted fishing vessels that have been fishing for 
federally managed species in the United States Economic Exclusion Zone (EEZ).  Biological 
sampling requests may vary by species and market category.  A basic sample of 100 fish measured 
and 25 fish must be selected on a stratified basis for aging (with the exception of shellfish) and the 
aggregate weight of the measured fished must be documented (BSWI 2.0).  When selecting fish for 
aging, at least one fish for each 1.0-cm interval as represented in the length sample must be contained 
in the age sample (the 1.0-cm rule). Measuring and handling techniques may also vary greatly, by 
species, as some samples use century structures to gather lengths while others require an entire fish be 
sent to the NEFSC for processing.  These differences are noted in the species specific work 
instructions.  (BSWI 4.0, 5.0, 7.0 and 9.0-9.23) 
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Post data gathering the data are transferred and manually documented on hard copy(BSWI 6.0).  
Immediately following the data are entered into the BSMDBS system to allow for proper tracking and 
forward targeting of gathered data versus requested(BSWI 8.0).  On a rolling basis the samplers will 
update or complete the sample using data from other datasets(BSWI 8.3).  


4.0 Authority and Responsibility 
The Biological Sampling Coordinator is responsible for ensuring that the requirements of this 
procedure are fulfilled and the samplers are adequately trained. Biological Samplers are responsible 
for performing activities described in this procedure. 


5.0 Activities 


 Resp. Activity Requirement 


5.1 Biological 
Sampling 
Coordinator 
(BSC) 
(Task 
Leader) 


Audits and displays the results of 
the sampling efforts. 


Review biological data for common cause 
errors and completeness, by geographic 
team. 


Compare the gathered biological data to 
the NEFSC request list and produce a 
‘Concerns Document’ for the field staff to 
use for targeting of data. 


Provide adequate training and support for 
all staff collecting biological data. 


5.2 Biological 
Sampler 


Target or identify biological 
samples. 


The samplers shall use all available 
methods to target landings that may have 
the need requests, based on the ‘Concerns 
Document’ or the NEFSC’s requests. 


• VMS Email 


• Concerns Document 


• BSMDBS 


• Hail Lines / Industry Contacts 


• Local Knowledge 


5.3 Biological 
Sampler 


Biological Sampling 


Biological Sampling (cont..) 


Biological data are gathered per the 
requirements set forth from the NEFSC 
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based on the species and market category. 


• Allegro Field PC 


• Punch Strips 


• Age Packets 


• BSWI 


5.4 Biological 
Sampler 


Transfer and handling of 
biological data. 


The gathered data, within a sample, are 
then tallied based on length interval and 
manually keypunched into the BSMDBS. 


Immediately after entry an audit is 
performed, LENGTH SAMPLES, to 
identify common cause or special errors. 


Corrections are made. 


Age structures are packaged and readied 
for shipment to the NEFSC. 


• BSMDBS 


• Age Packets 


• Fedex Boxes 


• BSWI 


5.5 Biological 
Sampler 


Biological data is updated and 
age packets are shipped to the 
NEFSC. 


 


 


 


 


 


 


 


Biological data are updated using several 
databases to verify the VTR Serial 
Number and Statistical Area Fished.   


Documentation are made within the 
BSMDBS and on existing age packets. 


Age packets are shipped to the NEFSC. 


Samples >60 days old are documented 
and forwarded to the BSC. 


• BSMDBS 


• VESLOG 
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Biological data is updated and 
age packets are shipped to the 
NEFSC. (cont…) 


• LES1 


• CFDERS 


• BSWI 


• LatLon Conversion Site 


 


6.0 Associated Documents / References 
BSMDBS  Biological Sample Monitoring Database System 
VMS                            Vessel Monitoring System 
VTR                             Vessel Trip Report 
VESLOG                     VTR data system 
CFDERS                      Commercial Fisheries Landings Database 
LES1                            Dealer reports, days at sea, VTR serial numbers and other vessel data 
Concerns Document    Excel based report 
BSWI                           Biological Sampling Work Instructions 
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Biological Sampling Work Instructions 


 
 


Syllabus 
 
This manual contains work instructions for conducting biological sampling at ports within the 
Northeast Region of the National Oceanic and Atmospheric Administration (NOAA) National 
Marine Fisheries Service (Fisheries).  This manual contains the standards to be followed by all 
Port Agents and NOAA Fisheries Contractors engaged in biological sampling at the port level, 
the authorities and instructions for data collection, and detailed descriptions of sampling by 
species.  
 
1.0 Stock Areas In The Northeast Area 


 
Species Name Stock Area Name Stock Area Region 


American Lobster South of Cape Cod – Long Island 538, 539, 611 
American Lobster Georges Bank – Mid Atlantic 520-526, 533, 534, 537, 540 
American Lobster Gulf of Maine  510-515 


American Plaice Gulf of Maine –  Georges Bank – Scotian Shelf 464, 465, 510-526, 551, 552, 
561, 562 


American Plaice Southern New England – Mid Atlantic 530-543, 600-639 
Angler  (Goosefish) Gulf of Maine – Northern Georges Bank 510-515, 521-523, 561 
Angler  (Goosefish) Southern Georges Bank – Mid Atlantic 524-526, 537-543, 562, 600-639 
Atlantic Cod Georges Bank – Mid Atlantic 520-639 
Atlantic Cod Gulf of Maine – Scotian Shelf 464, 465, 510-515 
Atlantic Croaker Southern New England – Mid Atlantic 530-543, 600-639 
Atlantic Herring Georges Bank – Southern New England 520-526, 561, 562, 530-539 
Atlantic Herring Gulf of Maine  510-515 
Atlantic Mackerel Gulf of Maine – Mid Atlantic 500-639 
Black Sea Bass Southern New England – Mid Atlantic 530-543, 600-639 
Bluefish Gulf of Maine – Mid Atlantic 500-639 
Butterfish Georges Bank – Mid Atlantic 520-639 
Cusk Gulf of Maine – Mid Atlantic 500-639 
Haddock Georges Bank – Southern New England 520-562 
Haddock Gulf of Maine – Scotian Shelf 464, 465, 510-515 
Haddock Mid Atlantic 600-639 
Ocean Pout Gulf of Maine – Mid Atlantic 500-639 
Ocean Quahog Gulf of Maine – Mid Atlantic 500-639 
Pollock Gulf of Maine –  Georges Bank – Scotian Shelf 464, 465, 500-639 
Red Crab Gulf of Maine – Mid Atlantic 500-639 
Redfish Gulf of Maine –  Georges Bank – Scotian Shelf 464, 465, 510-526, 561, 562 
Red Hake Gulf of Maine – Northern Georges Bank 510-523, 561 
Red Hake Southern Georges Bank – Mid Atlantic 524-539, 562, 600-639 
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Scup Georges Bank – Mid Atlantic 520-639 
Sea Scallop DE – MD – VA 620-629 
Sea Scallop Georges Bank – Northeast Peak 561, 562 
Sea Scallop Georges Bank – Southeast Part 525 
Sea Scallop Gulf of Maine  510-515 
Sea Scallop Great South Channel 521, 522, 526 
Sea Scallop New York Bight 610-616 
Sea Scallop Southern New England 530-539 
Sea Scallop VA – NC 630-639 
Shad Gulf of Maine – Mid Atlantic 500-639 
Shrimp Gulf of Maine  510-515 
Silver Hake Gulf of Maine – Northern Georges Bank 510-523, 561 
Silver Hake Southern Georges Bank – Mid Atlantic 524-539, 562, 600-639 
Spiny Dogfish Gulf of Maine – Mid Atlantic 510-515, 600-639 
Squid (Illex) Gulf of Maine – Mid Atlantic 500-639 
Squid (Loligo) Gulf of Maine – Mid Atlantic 500-639 
Summer Flounder Georges Bank – Mid Atlantic 520-639 
Surf Clam Gulf of Maine – Mid Atlantic 500-639 
Tilefish Georges Bank – Mid Atlantic 520-639 
Weakfish Southern New England – Mid Atlantic 530-539, 600-639 
White Hake Gulf of Maine – Southern New England 464, 465, 500-562 
White Hake Mid Atlantic 600-639 


Windowpane Gulf of Maine –  Georges Bank 
464, 465, 510, 515, 521, 522, 
525, 542, 543, 551, 552, 561, 
562 


Windowpane Southern New England – Mid Atlantic 526, 530-539, 600-639 
Winter Flounder Georges Bank 522, 525, 542, 543, 551 
Winter Flounder Gulf of Maine – Scotian Shelf 464, 465, 510-515 
Winter Flounder Southern New England – Mid Atlantic 521, 526, 530-541, 600-639 


Witch Flounder Gulf of Maine –  Georges Bank 464, 465, 510-526, 551, 552, 
561, 562 


Witch Flounder Southern New England – Mid Atlantic 530-543, 600-639 
Yellowtail Cape Cod 514, 521 
Yellowtail Georges Bank 522, 525, 551, 552, 561 
Yellowtail Gulf of Maine  510-513, 515 
Yellowtail Mid Atlantic 600-639 
Yellowtail Southern New England  526, 537-539 
Yellowtail Scotian Shelf 464, 465 
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2.0 Market Categories/Culling and the “Small Sample” 
 
Some species of fish are separated or “culled” by size or market category at sea while being 
unloaded, or after transshipment to another site such as an auction.  Culling is practical because 
of differences in prices for fish of different sizes.   
 
Requirements for samples by market category/fishing area/gear for a sampling area are updated 
annually and can be found on the NEFSC’s BSMDBS website.  
 
2.1 Requirements for Sampling Species by Market Category or Cull 
When sampling species by market category or cull, adhere to the following requirements: 
 


• When a species is culled, each cull or market category must be sampled individually. 
 
• Whether the species to be sampled is culled or is not normally culled (herring, whiting 


mackerel, etc.), the sampler must be able to identify the vessel landing the fish and the 
fishing area where the species were caught. 


 
• Market categories for a single sample must not be combined. 
 
• If market categories are landed separately but combined on the weighout, a sample must 


not be taken.  If a sample was inadvertently taken before this information was available, 
the sample must be discarded. 


 
• If there are too few fish in an individual catch to sample by species or market category, 


the sampler must never combine the catch of two or more vessels to make up the required 
amount, even if they know the fish are from the same sampling area.   


 
2.1.1 Requirements for Sampling Species in a “Small Sample” 
There are instances where a “small sample” can be justified.  A small sample is a sample in 
which the required number of fish cannot be obtained from any single vessel’s landings.  The 
rules to follow for this are: 
 


• If a regulated species is landed in a quantity smaller than required in this manual, a 
sample containing fewer length measurements is appropriate. 


 
• Age samples should still consist of one fish per 1.0-centimeter (cm) interval for all 


lengths in the sample (the “1.0-cm rule”). 
 


• If a small sample is all that is available, the sampler should try to meet the required 
number of lengths for a full sample of this species by obtaining additional small samples 
from other trips when they become available but must not be combined in the field.  
Small samples should be recorded in the same manner as a full sample.  
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3.0 Unloading Techniques and Sampling 
 
Unloading techniques are different in nearly every port.  The unloading method dictates when 
and how sampling is performed.  In Figure 3-1, each point in the unloading process is numbered. 
The numbers are used on the Length Sample Form (Figure 6-1) to indicate sampling method.  
Fish can be sampled at any point in the operation providing the rules for sampling sorted fish are 
observed. 
 


1
Vessel


2
Lumping Basket


4
Cart/Barrel
Large Box


5
Bin or Floor Pile


7
Sorting Table
Cutting Line


3
Chute or Conveyor


6
Small Box


 
Figure 3-1 


3.1 Rules for Sampling Sorted Fish 
 


1. Vessel or Hold Samples — Vessel, or hold samples, are least desirable for industrial 
species because of the problem of sampling bias.  If food fish must be sampled from the 
hold of a vessel, each market category must be sampled in the manner described below in 
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method number 6 if the fish have been culled at sea and separated by market category in 
the hold. 


 
2. Basket Samples — As fish are being unloaded from the lumping (unloading) basket, the 


sampler fills a sample basket/box by either scooping the fish from the pile, or by 
unloading fish from the lumping basket into the sample container.  If the latter method is 
used, a portion of fish from three or four lumping baskets must be included in the sample. 
Fish from no less than three lumping baskets must be measured.  Baskets are selected 
from the first, middle, and last part of the load.  This is the preferred method for unsorted 
or unculled species such as redfish and silver hake.  This sampling method is also 
recommended when fish are sorted on the boat before unloading and are resorted before 
weighout. 


 
3. Chute Samples — Fish that are passed through chutes or conveyors during or after 


unloading can be sampled by removing individual fish from the chute or conveyor until 
sufficient fish to complete the sample have been taken.  To ensure a random sample is 
obtained, sample fish from different parts of the load by allowing adequate time intervals 
between selections of fish.  The cautions regarding sorted fish apply here as well. 


 
4. Cart, Barrel, or Large Box Samples — For these samples, randomly select a cart, 


barrel, or large box into which sorted or unsorted fish have been placed for sampling.  It 
is preferred that a portion of the fish in the sample is measured from three or more 
containers.  Caution must be used in selecting fish from these containers for measurement 
so that no selection bias is introduced.  Note the number of containers sampled on the 
sample form. 


 
5. Bin or Floor Pile Samples — Sometimes fish are deposited in bins or on floor piles to 


await processing.  If the boat that caught the fish is known and the boat captain was 
interviewed, these fish may be sampled.  Fish must be scooped randomly from the bin or 
floor pile until sufficient fish are placed in the sample basket to meet the sampling 
requirements.  No less than three scoops (using a shovel) from three different points on 
the pile must be taken.  When fish are handled in the plant in this manner, they are 
usually unsorted.  When the fish are sorted by size, do not sample unless the sizes appear 
separately on the weighout. 


 
6. Small Boxed Fish Samples — This method refers to plastic 100-pound fish totes or 


waxed cardboard boxes of various sizes.  All fish in one box must be measured.  If the 
number of fish in an individual box is not sufficient to meet the sampling requirements,  


 
several boxes may have to be measured.  In a sorted landing, one or more boxes of each 
size or market category must be sampled. 


 
7. Sorting Table or Cutting Line — If sampling is at the cutting line or sorting table, 


every fifth fish must be selected as they are dumped onto the table or cutting line, as 
described above in number 3.  
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4.0 Measuring Fish for Length 
 
Most fish are measured by fork length.  Fork length is the distance between the tip of the snout 
and the fork in the tail.  Some species that have no pronounced fork in the tail are measured by 
midline length while other species have specific methods for measurement that are covered in 
Section 2.0.   
 
Fish are measured by using a special measuring board with punch strips, reusable plastic strips 
(its use is best shown by demonstration) or by recording data on field PC's (eSampling).  
Generally, fish are measured to the nearest 1.0-centimeter (cm).  For example, a fish measuring 
between 10.5 and 11.4 cm would be 11.0 cm, and a fish measuring between 25.5 cm and 26.4 cm 
would be 26 cm.  Redfish, yellowtail, lobster, and crabs are separated by sex before measuring 
and each sex group is recorded separately on the Length Sample Forms (Figure 6-1).  
Additionally, biological data can be sampled using the Allegro system. 
 
4.1 Procedures for Using Punch Strips 
There are four procedures for measuring fish by using punch strips. 
 


1. Using the Finfish Punch Strip for Fish 0-60 cm in Length.  
 


a) Enter the name of the vessel, date landed, and species-market category on the finfish 
punch strip by writing with pencil (even if it is wet) or scratching with an awl (Figure 
4-1). 


 
b) If the sample is to be sexed, use a punch strip with a line down the middle.  Write 


males above the line and females below the line and punch male fish on the upper 
portion and female fish below the line. 


 
c) Insert the punch strip into the slot on the measuring board until it contacts the end 


plate of the board.  If the strip is loose, put a crimp in the strip to keep it from 
moving.  To crimp the strip, insert it part way into the slot and bend it down slightly.  
A thumbtack may also be used to anchor the punch strip. 


 
d) Take the fish to be measured and place the nose against the end of board and make a 


punch mark with an awl at the midline end of the tail or at the fork.   
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Figure 4-1  Diagram of a Finfish Strip and Scallop Strip 
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e) Punch every fish in the sample on the strip and take age samples in the usual manner 


(see Section 9.0 for specifics).  Each time an age sample is taken, a scratch must be 
made at that interval to keep track of the number of age samples per interval taken (at 
least one age sample per 1.0-cm interval; the 1.0-cm rule). 


 
f) Once the sample is completed, add the number of punch holes in the interval to get 


the number of fish.  If the hole is punched on a line, determine which side the greater 
part of the hole is on and assign it to that interval.  Do not move fish or angle the awl 
to avoid hitting a line as this could introduce a bias. 


 
2. Using the Finfish Strip for Fish >60 cm in Length. 


 
a) For fish >60 cm in length, the finfish strip must be adjusted (Figure 4-1).  For 


example:  If the fish are between 60-100 cm, align the arrow at the 10-cm interval on 
the finfish strip with the 60-cm mark of the meter stick and write “60”on the top of 
the strip to indicate the starting point.  The numbers 65, 70, 75, 80, etc. can also be 
written to indicate reference points.  Proceed as before in number 1 above. 


 
3. Using the Plastic Strip 


 
a) The plastic strip is reusable and should not be punched with an awl.  The plastic strip 


is most often used for measuring white hake as they are generally landed headless and 
are difficult to accurately measure using the aluminum strip (see Section 9.12).  Use a 
grease pencil or a carpenter’s pencil to record information on the strip. Once all data 
is transferred onto the Length Sample Form (Figure 6-1), all marks can be cleaned 
off the strip with a household cleanser. 


 
NOTE: 
 The "Hake Strip" cm intervals are ⅔ of a cm to account for the headless state. 
 


4. Using the Scallop Strip 
 


a) Use the scallop punch strip’s 5-millimeter (mm) groupings (see number 1 above) to 
measure scallops (Figure 4-1).  These strips can be used to record two separate 
samples if the sampler is careful to record measurements on either end of the strip. 


 
b) Insert the strip into the end of the board and punch out the scallop measurement.  


Ensure that the awl is not angled; keep it perpendicular to the board.  Add the number 
of holes per interval and transfer the information to the sea scallop column on the 
Length Sample Form (Figure 6-1).  When using a scallop measuring board, the use of 
scallop punch strips is optional. 


 
c) The aluminum punch strip used for finfish sampling is also acceptable for measuring 


scallops; however, it is important to remember the 5-mm groupings for this species.   
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NOTE: 


1. Retain all finfish and scallop punch strips used for recording samples for 3 years.  
These strips provide hardcopy records of the samples in case any questions arise later 
regarding a sample.  After 3 years, recycle the strips properly. 


 
2. If the strip is a little loose, it can move.  Watch the strip to make sure that it does not 


shift.   
 


3. Sometimes a fish will be off the strip.  In this case, measure the fish on the meter stick 
and write the length on the strip.  All the lengths must be punched or written (if the 
fish is off the strip) on the punch strip. 
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5.0  eSampling Biological Data Protocol 
 


The following protocols should be used when using the Allegro system to eSample biological 
data. 
 


1. Getting Started, prior to leaving the office 
 


a) Turn on the Allegro system (bottom right corner of unit). 
 →Select START. 


→Select PROGRAMS. 
→Select FISHSAMPLING and select OK, (wait about 30 seconds for the  


program to fully load and become active) this brings up the HEADER 
DATA table. 


 
2. Header Data Collection 


 
a) DATE is automatically filled based on the time and date set on the Allegro.  If the 


date is not current, select NEW on the top toolbar.   If the date is still incorrect you 
will need to reset the date on the Allegro (touch the clock on the screen and select the 
correct date and time). 


 
b) Press the F2 key to drop down PORT list and select the correct sampling port. 
 
c) Press the F1 key—presents full screen table view of header data. 
 
d) Fill in HEADER DATA as appropriate, use the TAB key to toggle between fields or 


ENTER key to enter a value. 
 
 
NOTE:  


The minimum amount of data need for these fields would be (Port, Ves1, NES3, NES4, 
AgeS, Sam1, Sam2, FPC#, E.Fish)  ALL of these fields have DROP DOWN lists by  
 
using the F2 key.  E.Fish sets the biological template to the estimated number of fish you 
will sample and is not changeable once selected for an individual sample; you may set 
this to a higher level to prevent having to weigh a partial box while sampling. 


 
e) Press the F1 key—returns to data sheet view of header data. 


 
3. Biological Data Collection 


 
a) Press the F5 key (ViewFishList) and wait 15 seconds for appropriate 4 column data 


sheet to load. 
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b) Select from the ACCESSIBLE FIELDS SETTING menu (pop-up), if it does not 
pop-up, select FILE then ACCESIBLE FIELDS, check fields you want to SKIP 
(AGE TAKEN—counts the number of age structures and identifies which fish they 
were gathered from, WEIGHT—this field is to gather individual lengths, SEX—if 
sexing is not required). 


 
c) Select SET.  The following data fields can then be entered: 


 
SEX field will only accept  0 – unknown, 1 – Male, 2 – Female, and will auto 
advance to the next cell upon selecting the value. 
 
AGE TAKEN will only accept 0 - not taken, 1 – taken, and will auto advance to the 
next cell upon selecting the value(use this selection for special studies). 
 
LENGTH(cm) will accept a value with 4 digits (1234).   Select ENTER to advance 
to the next cell. 
 
WEIGHT(lbs) will accept a value with 7 digits (1234567).  Select ENTER to 
advance to the next cell—typically the next fish to be sampled (individual weights 
may be needed for special studies). 
 
Repeat the process as needed to gather required data for the sample. 
 
Most samples will only require a LENGTH value to be entered.  Enter the value and 
select ENTER to move to the next LENGTH field. 
 


d) After all lengths have been gathered, place the T_S_WEIGHT into the WEIGHT 
column.  For a sexed sample, enter 1 for MALE in the SEX column and place the 
weight for all of the males into the WEIGHT cell.  Then go to the next line and enter 
2 for FEMALE in the SEX column and place the weight for all of the females into 
the WEIGHT column. 
 


e) This sample is complete.  Select F5 (ViewHeaderList) 
 


4. Next or New Sample 
 


a) Select NEW from the HEADER to create another sample header. 
 


b) Press the F1 key and repeat the entire above process from the * place. 
 


5. Saving Data or Ending the Sampling Event 
 


a) When a sampling event is complete select FILE from the top toolbar. 
→Select EXIT. 
→Select YES. 
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The sample file will name itself upon exiting (DATE-PORT-FPC#).  For example:  
 
 20041208-220101-5 (for December 8, 2004 in Portland, ME using PC# 5) 
 
If another sample from the same port on the same day is to be done after exiting the program you 
will have to rename the previous file to avoid over-writing that sample.  To rename a file on the 
Allegro: 
 


1. Select MY DOCUMENTS. 
 
2. Single tap (highlight) on file to be renamed. 
 
3. Select FILE from top toolbar. 
 
4. Select RENAME—Rename the sample file, possibly by adding an a, b, c, etc. to the end 


of the name. 
 
5. Press ENTER on the Keypad. 


 
NOTE: 


All data should be saved to a disc and saved for three years for future reference.  Any and all 
issues should be reported to the Biological Sampling Coordinator. 
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6.0 Length Sample Form 
 
The Length Sample Form (Figure 6-1) is used to record length frequency data for all species 
(i.e., the lengths and the number of specimens at each length for the biological samples taken 
[one species per form]).  It is also used to indicate how many individuals were selected for aging. 
For a sample where sexes must be differentiated, the Length Sample Form is divided into two 
sections, one for males and one for females.  The section on the right side of the form is set aside 
for recording shell height frequencies for sea scallops.  Entries as numbered and shown in Figure 
6-1 are presented in Figure 10-1. 
 
The Length Sample Form is designed for entry into the CODES system.  The computer can 
automatically transfer weighout entries for the shaded items on the form, from the weighout 
record into the computer length record of the form. 
 
If a whole length sample is frozen for later processing, a Length Sample Form must be 
completed with the word FROZEN written in red across the face of the form.  This will aid in 
accounting for samples. The Length Sample Form must then be sent to: 
 
NOAA Fisheries 
166 Water Street 
Woods Hole, MA 02543-1097 
(508) 495-2000 
FAX (508) 495-2258 
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Figure 6-1.  Length Sample Form
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6.1 Information Needed to Complete the Length Sample Form 
 


Item Entry 
1. Docn  The document number that appears on the related weighout. 
2. Vessel-1 Name The name of the vessel landing the catch. 
3. Vessel-1 Code The code of the vessel landing the catch. 
4. Vessel-2 Name The name of the vessel that was paired, or involved, in the catch. 
5. Vessel-2 Code The code of the vessel that was paired, or involved, in the catch. 
6. Year The year landed. 
7. Month The month landed. 
8. Day Landed The day landed. 
9. Species Name (Mkt Cat) The name and market category of the species sampled. 
10. Species Code The 4-digit species code of the species sampled. 
11. Sampling Method The code for the method used to sample the vessel’s catch:  1=vessel or hold; 2=basket 


or bushel; 3=chute or conveyor; 4=cart, barrel, or large box; 5=bin, floor pile; 6=small 
box; and 7=sorting table. 


12. Sex Code The code(s) for the sex (es) of the sample, as follows: unsexed=0; male=1; female=2; 
and males & females=1/2. 


13. Scales, Oto's, Other Check the appropriate box to indicate what structures were taken for aging. 
14. M, F, Tot The number of males and/or females and the total, or the number of unsexed, from 


which age structures were taken, in the appropriate boxes. 
15. Landed Weight The landed weight of the market category sampled, in thousands of pounds to one 


decimal place (e.g., 3500 lbs = 3.5). 
16. Disposition The catch from which the sample was taken: discarded=0 and kept=1. 
17. Sample Weight: Males The weight of the males in the length sample to the nearest pound. 
18. Sample Weight: Females The weight of the females in the length sample to the nearest pound. 
19. Sample Weight: Total The total weight of the length sample to the nearest pound. 
20. Length Precede the number in the length column with the proper number(s) to identify the tens 


and/or hundreds. 
21. Number-at-length Indicate the number-at-length in the blank box adjacent to the length. 
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7.0  Scale and Otolith Samples 
 
Fish taken for aging are selected so that at 
least one fish for each 1.0-cm interval (as 
observed in the length sample; the 1.0-cm 
rule) is represented by a fish of that length 
in the age sample.  This is called a stratified 
sub-sample.  Record the length on each 
Scale Envelope and, for sexed samples, 
record the sex on each Scale Envelope. 
 
Scales are needed from specific areas for 
certain fish types.  Figure 7-1 shows these 
areas on a round (cod/haddock type) and a 
flat (flounder) fish.  If scales cannot be 
found in the areas designated, scales can be 
taken from other areas of the fish with the 
area sampled indicated on the Scale 
Envelope. 
 
 


 
 
 
 
 
 


Figure 7-1.  Areas for Scale Removal in Round or Flat Fish 
 
7.1 Scale Sampling Procedure 


 
Before removing scales from a fish: 


1. Firmly scrape the slime and mucus away with the scale knife.  If this is not done, the 
scales will rot in the envelopes, rendering the sample useless. 


 
2. After scraping away the slime, first clean the knife and then scrape against the grain of 


the scales until 10 or 20 scales have been removed from the fish. 
 
3. Place these scales between the leaves of a slip of paper and then put them in the Scale 


Envelope, remembering to indicate the length of the fish on the envelope and sex (if sex 
is required). 


 
4. Repeat this procedure with each fish. 
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7.2 Otolith Sampling Procedure 
 


Removing otoliths may best be explained by demonstration.   
1. It is important to remember that there is a thin membrane or sac surrounding each otolith. 


This membrane must be removed before putting the otolith in the Scale Envelope.  If the 
membrane is not removed, it will harden upon drying making the otolith difficult to read.  


 
2. Each pair of otoliths belongs in a separate Scale Envelope. 


 
7.3 Age Structure Envelopes 
 
The age structures removed from an individual specimen are placed in an Age Structure 
Envelope and the information given below is entered on one header envelope for each sample 
and sex sample (Figure 7-2).  The length and, if appropriate, the sex must be indicated on every 
Age Structure Envelope.  If samples are frozen for later processing, they must be labeled with the 
same information required on the header envelope.  The required Scale Envelope header 
information is presented in Table 7-4 
 


DOCN # _____________________ 
Vessel Name _________________ 
Port _________________________ 
Date_________________________ 
Area_________________________ 
Species Name__________________ 
Mkt. Cat. _____________________ 
Length ________________________ 
Sex      un______ M _____ F ______ 


Catch Disposition  0_______ 1 __________ 
VTR #________________________ 
Name _________________________ 


Figure 7-2.  Age Packet Envelope Header 
 
7.4  Scale Envelope Header Information to be Entered on the Age Structure Envelope 
 
Item Entry 
1. Docn. The document number that appears on the related weighout. 
2. Vessel Name The name of the vessel landing the catch. 
3. Port The name of the port where the catch was landed. 
4. Date The date the catch was landed. 
5. Area The Northeast Marine Fisheries Information System area in which the catch was made. 
6. Species Name The name of the species sampled. 
7. Mkt. Cat The market category of the species sampled. 
8. Length The length of the individual from which the sample was taken. 
9. Sex The sex of the individual from which the sample was taken. 
10. Catch Disposition Indicate whether the catch from which the sample was taken was: discarded = 0 or kept = 1. 
11. Name The name of the sampler. 
12. VTR The vessel trip report number. 
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8.0  Biological Sample Monitoring Database (BSMDBS) Data Entry Protocol 
 
The following protocol has been established for entering data into the BSMDBS. 
 
8.1 BSMDBS Data Entry Protocol 
 


1. Entering Biological Sample Data on BSMDBS 
 


b) Enter the Northeast Fisheries Science Center (NEFSC)Web Site 
http://dbs.wh.whoi.edu/bsmdbs/ 
→Select the WEB-BASED DATA ENTRY icon. 
→Select DATA ENTRY FORMS. 
→Enter your USERNAME, PASSWORD and  DATABASE. 
→Verify that the year is correct (2005). 
→Select BIOLOGICAL SAMPLE ENTRY (wait a few seconds). 


 
c) Header Information. This data cannot be changed after its creation, in the field. 


For Header Information enter the NAME of individual entering the sample (Last, 
First), PORT NAME (port where sample is being entered) and TALLY DATE (date 
which sample is being entered [03/15/2005]). 


 
d) Sampler Data must be recorded. 


→Enter the Sampler ID1 (P43) # of individual that took the sample and press 
ENTER.  If applicable, enter the Sampler ID2 (P48) # of the individual that 
assisted with the sample and press ENTER.  If a new sampler is needed, select the 
NEW SAMPLER button and follow instructions. 


 
e) Biosample Header Information is then entered into the PORT SAMPLE TALLY  
 


SHEET).  The following header information fields must be entered: 
 
PERMIT is the 6 digit Permit Number (123456 [Hull Number and Vessel Name 
will be filled automatically]). 
 
DATE LANDED is the Date the catch was landed (3/14/2005).  Complete year 
must be entered. 
 
PORT is the port landed 6 digit Port Code (123456) of the port where sample was 
taken. 
 
NESPP3 is the 3 digit Species Code (123) for the species sampled. 
 
MKT CAT is the Market Category, which is the 4th digit of the 4 digit Species 
Code (1). 
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LENGTHS is the Number of Total Lengths (###) taken in the sample. 
 
AGES is the Number of Ages (##) taken for the sample; enter 0 if none taken. 
 
STOCK AREA (use drop down menu) is completed only if data was available to 
sampler. 
 
NE GEAR is the 3 digit Gear Code (123) used by the vessel. 
 
NEMAREA is the 3 digit Statistical Area (123), and is used if data was available to 
the sampler. 
 
DATA SOURCE is how trip data was gathered (VTR, Interview). 
 
VTR LOG#  is the Trip ID acquired from dealer at the point of sampling.  
 
DOCN is the number assigned by using first number of 1 site code per office. 


 
f) With the header data entered  select  SAVE, below DOCN and then use the < button 


to toggle back to original header entry   
 


g) Select ENTER LENGTHS, which opens the BIOSAMPLES LENGTHS FORM. 
 


h) With date from the BIOSAMPLES LENGTHS FORM, verify that the Tally #, 
Sample #, Species and MktCat are correct.   


 
 
 


 
Enter the following fields using the correct codes: 


 
SEX will accept values from 0 to 2.  If sexed, enter MALES first, see m) below for 
FEMALES 


0 – Unsexed  
1 – Male  
2 – Female 


 
CATDISP will accept values of  0 or 1. 


0 – Discard  
1 – Kept 
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WGTSAMP it the total weight of sample or for individual sex, if sexed. 
SAMPMETH is the method of sampling; values accepted are from 1 to 7. 


1 – Vessel 
2 – Lumping Basket 
3 – Chute or Conveyer 
4 – Cart/Barrel/Large Box 


5 – Bin or Floor Pile 
6 – Small Box Fish 
7 – Sorting Table or Cutting Line 


    
AGESTRCT is the age structure sampled; values accepted are from 0 to 6. 


0 – None 
1 – Scales 
2 – Otoliths 
3 – Shells 


4 – Pen 
5 – Vertebra 
6 – Organism 


 
AREASAMP is the stock area captured from VTR or Interview. 
 
AREASRC is the method in which AREASAMP was gathered; values accepted are 
from  0 to 3. 


0 – Unknown 
1 – Weigh-Out 
2 – Interview 
3 – Port Agent's Best Guess 


 
LENGTH is the length measurement (the centimeter or mm interval). 
 
NUMLEN is the number of lengths for the adjacent LENGTH value.  


 
i) Select SAVE on the BIOSAMPLES LENGTHS FORM to save the length sheet. 


 
j) Select EXIT on the BIOSAMPLES LENGTHS FORM to return to the header 


information. 
 


k) Select SAVE to save the entire sample and start a new sample. 
 


l) Select EXIT to exit the system after entering all of your samples 
 


m) For SEXED samples select ENTER LENGTHS.  Verify that the Tally #, Sample 
#, Species and MktCat are correct. 


 
 







 
NERO                                                     Biological Sampling Work Instructions        Rev.0                                        March 2, 2010   


21 


n) Enter the biological data from either sex of the sample and select SAVE. 
 


o) Follow the below sequence to add the other SEX record: 
Adding a Second Sex Record 
 
Since SEX and CATDISP are part of the primary key, data for more than one sex can 
be entered by entering separate records for each sex.  The user must enter the first 
SEX record and save it.  Then the  Top Menu must be used to enter the second SEX 
record (see image below). 
 


 
This is done by performing the following: 
 
The cursor must be in the SEX field.  Next, from the Top Menu, select the 
RECORD option, then INSERT (which will clear out the fields).  Then, again from 
the RECORD option, select DUPLICATE.  This will put the data from the last 
record into this new record.  Now change the the sex and whatever else needs to 
change (except the Header Information).  Then select  SAVE from the bottom 
button bar to save the second SEX record.  Both records should then be in the 
database.  This can be verified by putting the cursor in the SEX field and using the 
UP and DOWN arrow to see all the records for that header combination. 
 


p) Select SAVE to save this sexed record 
 


q) Select EXIT to leave the length form  
 


2. Updating Biological Sampling Data on BSMDBS 
 


b) Enter the NEFSC Web Site. 
→Select the Web-Based Data Entry button. 
→Enter your USERNAME, PASSWORD, DATABASE 
→Verify that the year in which the sample was taken is correct. 
→Select Biological Sample Update. 


 
c) Select the ENTER QUERRY button and enter the following fields: 
 


PERMIT is the 6 digit Vessel Permit Number (123456) 
 
DATE LANDED is the Date the catch was landed (3/14/2005)  
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d) Select the EXECUTE QUERRY button. Sample data for this vessel and date will 


appear (this will take a few seconds). 
 


e) Update sample data accordingly in appropriate fields (STOCK AREA, NEMAREA, 
DATA SOURCE, VTR LOG #, LENGTH DATA, etc.) 
 


f) To update another sample from the same vessel on the same date, select the > button. 
 


g) To save updates for this vessel and date, select SAVE. 
 


h) To add or edit lengths, select the ENTER LENGTHS button. 
 


i) Length data form (BIOSAMPLES LENGTHS FORM): 
SEX will accept values from 0 to 2.  If sexed, enter MALES first.  Refer back to m) 
in the above Entering Biological Sample Data on BSMDBS section for FEMALES 


0 – Unsexed  
1 – Male  
2 – Female 


 
CATDISP will accept values of  0 or 1. 


0 – Discard  
1 – Kept 
 


WGTSAMP it the total weight of sample or for individual sex, if sexed. 
 
SAMPMETH is the method of sampling; values accepted are from 1 to 7. 


1 – Vessel 
2 – Lumping Basket 
3 – Chute or Conveyer 
4 – Cart/Barrel/Large Box 


5 – Bin or Floor Pile 
6 – Small Box Fish 
7 – Sorting Table or Cutting Line 


    
AGESTRCT is the age structure sampled; values accepted are from 0 to 6. 


0 – None 
1 – Scales 
2 – Otoliths 
3 – Shells 


4 – Pen 
5 – Vertebra 
6 – Organism 


 
AREASAMP is the stock area captured from VTR or Interview. 
 
AREASRC is the method in which AREASAMP was gathered; values accepted are 
from  0 to 3. 


0 – Unknown 
1 – Weigh-Out 
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2 – Interview 
3 – Port Agent's Best Guess 


 
LENGTH is the length measurement (the centimeter or mm interval). 
 
NUMLEN is the number of lengths for the adjacent LENGTH value.  


 
r) Select SAVE on the BIOSAMPLES LENGTHS FORM to save the length sheet. 


 
s) Select EXIT on the BIOSAMPLES LENGTHS FORM to return to the header 


information. 
 


j) For SEXED samples, refer back to m) in the above Entering Biological Sample 
Data on BSMDBS.  


 
k) To update another sample from a different vessel go to and select the ENTER 


QUERRY button and start the process again from step c) above.  
 
Repeat steps until all samples are updated with appropriate data. 


 
NOTE:   


Ongoing projects may have additions to this protocol and should be adhered to, to preserve 
the quality of the data and its flow (i.e. enter area fished in comments section for Cod, 
Haddock, Yellowtail and Black Back). 


 
8.2 VERIFICATION and AUDIT PROCESS 


  
To verify the entered sample data go to the BSMDBS homepage at 
http://dbs.wh.whoi.edu/bsmdbs/ 
→Select REPORTS and choose your sampling area, the current month, and verify year  


is correct. 
→Select the LENGTH SAMPLES LIST button.  This displays ALL length data  


entered for the selected area for the given year.   
→Review your data and make corrections as needed, through the UPDATES  


screen. scrolling to the bottom of the report provides a summary that will 
indicate if errors have occurred. 
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8.3 Biological Sample AREA and VTR# Assignment Flow (Figures8-1 and 8-2) 
 


1. These data are assumed to be perfect matches as entered by the Center staff using the 
CAREA. 


 
2. With a landing date three days to either side of the sampled date but with a date sailed 


definitely prior to the sampled date.  Also review the VTR for the correct SPECIES, LBS 
LANDED and DEALER.  If questionable assume yes and continue through the matrix for 
verification in DAS and DER. http://www.nefsc.noaa.gov/veslog/test/index.html 


 
3. 60 days should be an adequate time frame to have the VTR submitted(45 days), scanned 


and entered into VESLOG 
 


4. Some species may not require the use of a DAS.  ALL TRIPS landing American Plaice, 
Atlantic Cod, Atlantic Halibut, Haddock, Ocean Pout, Offshore Hake, Pollock, Red 
Hake, Redfish, Silver Hake, White Hake, Windowpane Flounder, Winter Flounder, 
Witch Flounder, Yellowtail Flounder, Red Crab and Monkfish from the EEZ as well as 
Scallop-limited access vessels REQUIRE DAS usage.  http://les1 ‘DAS Report’ 


 
5. A DAS record that matches the VESLOG VTR (date sailed/landed).  


http://www.nefsc.noaa.gov/veslog/test/index.html 
 


6. To determine landings you may use the LES1 site or a query tool on ER_MV (CUDA1).  
Query by DATE and DNUM (DEALER NUMBER) or PERMIT (VESSEL PERMIT). 
http://les1 ‘Mults Catch Report’ 


 
7. This data will be entered onto the BSM by the field staff through the updates screen prior 


to sending the ages to the Center.  Gather the CAREA by using the website (provided by 
NEFSC)  http://nefsc.noaa.gov/loranconv/latlonarea.pl  


 
8. To determine whether a vessel has an active FEDERAL Permit us this site: http://les1 


‘Permit History’ 
 


9. Based on local knowledge, time of year, fishery dependent and other resources. 
 


10. Verification of a research cruise. http://les1 ‘IVR EFP & Research Reports’ 
 


11. Use the ‘Table for Assigning Stat Area’ to label the biological data. 
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Figure 8-1 Biological Sample AREA and VTR# Assignment Flow
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Figure 8-2 Biological Sample AREA and VTR# Assignment Flow
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9.0 Sampling Requirements by Species 
 
A summary of sampling requirements, by species, is noted with each below.  For species not 
specifically referenced, a basic sample of 100 fish measured from each market category per month 
must be taken and 25 fish must be selected on a stratified basis for aging (with the exception of 
shellfish).  When selecting fish for aging, at least one fish for each 1.0-cm interval as represented in 
the length sample must be contained in the age sample (the 1.0-cm rule).  
 
Each market category will be considered a separate sample.  The number of fish and age 
structures (otoliths or scales) required per sample are shown in the species specific tables that 
accompany the individual work instructions.  When selecting fish for aging, at least one fish for 
each 1.0-cm interval as represented in the length sample must be contained in the age sample 
(the 1.0-cm rule). 
 
For other finfish, not specifically discussed here, a basic sample of 100 fish measured from each 
market category per month, with 25 fish selected on a stratified basis for aging (using the 1.0-cm 
rule) are taken until procedures are developed for the species.  
 
 
Note: When a species mix is noted the identified species must be broken out and recorded as a 
separate sample with a notation in the COMMENTS field, on the BSMDBS, that the samples 
were gained from the same landing. 
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9.1 Cod, Haddock, and Pollock 
 


 
 


Species Name MKT NAME NESPP3 MKT CAT Lengths Sexed Scales Otos Freeze Units  Remarks 
COD WHALE 81 0 100 N   20     
COD LARGE 81 1 100 N   20     
COD MARKET 81 3 100 N   20     
COD SCROD 81 4 50 N   10     
COD UNCLASSIFIED 81 5 100 N   20     
COD STEAKER 81 6 100 N   20     
COD SNAPPER 81 7 50 N   10     
COD UNCLASSIFIED 81 8 100 N   20     
HADDOCK LARGE 147 0 100 N   50     
HADDOCK SCROD 147 5 50 N   25     
HADDOCK SNAPPER 147 6 100 N   50     
HADDOCK UNCLASSIFIED 147 7 100 N   50     
HADDOCK UNCLASSIFIED 147 9 100 N   50     
POLLOCK UNCLASSIFIED 269 1 100 N   20     
POLLOCK STEAKER 269 2 100 N   20     
POLLOCK MEDIUM DRAWN 269 3 100 N   20     
POLLOCK LARGE ROUND 269 4 100 N   20     
POLLOCK UNCLASSIFIED 269 5 100 N   20     
POLLOCK LARGE DRAWN 269 6 100 N   20     
POLLOCK SMALL ROUND 269 7 100 N   20     
POLLOCK SMALL DRAWN 269 8 100 N   20     


 
 
When sampling age structures of cod, haddock and pollock, only one otolith from each fish is 
typically required and it must not be crystallized or broken.  Both otoliths can be taken if time 
allows so that the second otolith can be archived for future genetic study or age and growth 
work.  Both age structures should be packaged in the same envelope when forwarding them to 
the NEFSC.  
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9.1.1 Steaker Cod Biological Sampling Protocol 
 


In an attempt to classify and account for all market categories within species that are landed a 
protocol for Steaker Cod, landed ‘headless’, has been developed.  These landings can be very 
seasonal in nature and may be localized within a few ports, depending on market conditions.   
 
The length required is achieved by using a centerline measurement from the point of attachment 
of the first Dorsal Fin to the centerline of the caudal fin, see below.  Place the ‘Steaker Cod’ on 
the board with the anterior insertion of the first dorsal fin aligned with the 0-cm mark and gather 
your length from the center-line of the caudal fin.  The aggregate weight of the sample is then 
recorded and there will be no resulting age structures as the head has been removed, there may 
be exceptions to the age rule and they should be gathered when available. 
 
 


 
 
 
The typical sample definitions pertain to this market category and a sample is made up from 100 
fish lengths with an aggregate weight.  The NESPP3 is 081 with a MKT CAT of 6 (NESPP4 = 
0816). 
 
 
 
 
 
 
 
 


Anticipated Cut Line 
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9.1.2 Whole / Steaker Cod Biological Sampling Protocol 
 
 


In an attempt to develop a conversion factor for ‘Steaker Cod’ data are needed from port 
sampling activities.  This protocol is for all market categories of Atlantic Cod.  When setting up 
the Allegro Fish Sampling software, the reflective market category is for the whole fish and on 
the biological data page the weight field should be left unchecked as to allow each weight field 
to be used.  The sample weight can be entered in the comments field or at the end of the sample 
in the next ‘blank’ weight field.    
 
To gather the necessary data you should place the fish on the board with the head end at ‘zero’ 
and gather the centerline length for the entire specimen.  Place the CM value in the LENGTH 
field and PRESS enter on the Allegro, which advances you to the ‘weight field’ which is now 
being used to capture the ‘anticipated steaker’ length.  Flip the fish so the caudal fin is at ‘zero 
and record where the anterior insertion of the first dorsal fin aligned, you may use a ruler or 
straight edge to ease of reading (only gather the ‘Anticipated Steaker Length’ in this manner).   
 
 
 


 
 
When entering the sample into the BSMDBS treat it as a ‘normal’ Cod sample and attribute the 
data to the usual market category for a ‘whole’ fish.  DO NOT ENTER the STEAKER DATA 
into the BSM.  Keep the sample’s data intact, where the two lengths correspond with each (an 
spreadsheet will be developed to capture and report the data). 
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9.2 Redfish 


 
 


Species Name MKT NAME NESPP3 MKT CAT Lengths Sexed Scales Otos Freeze Units  Remarks 
REDFISH UNCLASSIFIED 240 0 100 Y   20   otos: 10Male+10Female 
REDFISH LARGE 240 1 100 Y   20   otos: 10Male+10Female 
REDFISH SMALL 240 2 100 Y   20   otos: 10Male+10Female 


 
A redfish length sample consists of 100 fish sorted by sex.  Select a minimum of 10 males and 10 
females from the length sample for extracting otoliths with at least one fish per 1.0-cm interval 
(the 1.0-cm rule). 
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9.3 Silver Hake 


 
 


Species Name MKT NAME NESPP3 MKT CAT Lengths Sexed Scales Otos Freeze Units  Remarks 
HAKE, SILVER ROUND 509 0 100 N         
HAKE, SILVER KING ROUND 509 1 100 N         
HAKE, SILVER SMALL ROUND 509 2 100 N         
HAKE, SILVER DRESSED 509 3 100 N         
HAKE, SILVER JUVENILE 509 4 30 N         
HAKE, SILVER LARGE ROUND 509 5 100 N         


 
A silver hake sample consists of 100 measured fish.  No age structures or sexing of fish is 
required. 
 
Note: When a species mix is noted the identified species must be broken out and recorded as a 
separate sample with a notation in the COMMENTS field, on the BSMDBS, that the samples 
were gained from the same landing. 
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9.4 Black Back, Dab, Grey Sole, and Windowpane Flounder 


 
 


Species Name MKT NAME NESPP3 MKT CAT Lengths Sexed Scales Otos Freeze Units  Remarks 
FLOUNDER, AM. PLAICE UNCLASSIFIED 124 0 100 N   25     
FLOUNDER, AM. PLAICE LARGE 124 1 100 N   25     
FLOUNDER, AM. PLAICE SMALL 124 2 50 N   10   scales if otos not avail 
FLOUNDER, AM. PLAICE JUMBO 124 3 100 N   25     
FLOUNDER, AM. PLAICE MEDIUM 124 4 100 N   25     
FLOUNDER, AM. PLAICE PEEWEE 124 5 50 N   10   scales if otos not avail 
FLOUNDER, SAND-DAB UNCLASSIFIED 125 0 100 N 25       
FLOUNDER, SAND-DAB LARGE 125 1 100 N 25       
FLOUNDER, SAND-DAB SMALL 125 2 100 N 25       
FLOUNDER, WINTER UNCLASSIFIED 120 0 100 N 25       
FLOUNDER, WINTER LEMONSOLE 120 1 100 N 25 25   otos (preferred)  
FLOUNDER, WINTER LARGE 120 2 100 N 25 25   otos (preferred)  
FLOUNDER, WINTER SMALL 120 3 50 N 10       
FLOUNDER, WINTER X-LARGE 120 4 100 N 25 25   otos (preferred)  
FLOUNDER, WINTER LARGE/MIX 120 5 100 N 25 25   otos (preferred)  
FLOUNDER, WINTER MEDIUM 120 6 100 N 25       
FLOUNDER, WINTER PEEWEE 120 7 50 N 10       
FLOUNDER, WITCH UNCLASSIFIED 122 0 100 N   25     
FLOUNDER, WITCH LARGE 122 1 100 N   25     
FLOUNDER, WITCH SMALL 122 2 50 N   10   scales if otos not avail 
FLOUNDER, WITCH LARGE 122 3 100 N   25     
FLOUNDER, WITCH MEDIUM 122 4 100 N   25     
FLOUNDER, WITCH PEEWEE 122 5 50 N   10   scales if otos not avaiL 


 
Measure 100 fish from each market category landed (except small) and take 25 age samples from 
each market category sample, making sure that at least one fish from each 1.0-cm interval 
represented in the length sample is also represented in the age sample (the 1.0-cm rule).  No 
separation by sex is necessary for these species.  For the small market category, measure 50 fish 
and take 10 age samples with at least one age per 1.0-cm interval. 
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9.5 Yellowtail 
 


 
 


Species Name MKT NAME NESPP3 MKT CAT Lengths Sexed Scales Otos Freeze Units  Remarks 
FLOUNDER, YELLOWTAIL UNCLASSIFIED 123 0 100 Y 30     scales: 15Male+15Female 
FLOUNDER, YELLOWTAIL LARGE 123 1 100 Y 30     scales: 15Male+15Female 
FLOUNDER, YELLOWTAIL SMALL 123 2 100 Y 30     scales: 15Male+15Female 


 
Separate 100 yellowtail into males and females and measure and record separately.  Sex 
determination is performed by the candling method (best learned by demonstration).  Each 
market category is treated as a separate sample.  Fifteen fish of each sex are selected for aging 
according to the 1.0-cm rule.   
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9.6 Sea Herring 


 
 


Species Name MKT NAME NESPP3 MKT CAT Lengths Sexed Scales Otos Freeze Units  Remarks 
HERRING, ATLANTIC UNCLASSIFIED 168 5   N     50   


 
A sea herring sample consists of 50 fish frozen for later age and growth work by the Maine 
Department of Marine Resources (DMR).  It is not necessary to do length frequencies at the 
ports.  The sea herring are randomly selected from the catch and placed in the herring boxes 
supplied by the Maine DMR.  Ensure that all requested information printed on the box is 
completed.  If more than one box is needed for the 50 (+) fish sample, tape the boxes together 
and number (1 of 2, 2 of 2, etc.)  Plastic bags may be used if the boxes are not available and each 
bag must be identified with all the information required on the Scale Envelope. 
 
Before sampling, determine the identity of the vessel, catch location, and date fished.  Obtain the  
federal Vessel Trip Report (VTR) logbook serial number (located in upper right hand corner of 
VTR) for the trip and include it in the sample information.  This serial number will be used as the 
“vessel trip identifier.”  If the VTR is not available, the sampler should conduct a standard 
interview and, at the very least, obtain the minimal data elements of vessel name, number 
(federal or state), and date sailed. 
 
For ports south of Boston, Massachusetts, the frozen sea herring samples will be forwarded to 
the NOAA Fisheries NEFSC for transshipment to the Maine DMR lab in Boothbay, Maine.   
 
Send the samples to: 
Age and Growth - Jay Burnett 
NOAA Fisheries NEFSC 
166 Water Street 
Gloucester, MA  02543-1097 
(508) 495-2000 
FAX (508) 495-2258 
Jay.Burnett@noaa.gov 
 
Kohl Kanwit - Maine Department of Marine Resources 
P.O. Box 8 
West Boothbay Harbor, Maine 04575 
(207) 633-9500 
FAX (207) 633-9579 
 
If sea herring samples must be purchased, the sampler will contact the Biological Sampling 
Coordinator for instruction. 
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9.7 Other Herring 
 


           
 


Species Name MKT NAME NESPP3 MKT CAT Lengths Sexed Scales Otos Freeze Units  Remarks 
SHAD, AMERICAN BUCK 347 1 100 N   25     
SHAD, AMERICAN UNCLASSIFIED 347 4 100 N   25     


 
If other species of herring are mixed in with sea herring, and it is possible to obtain 50 fish, 
identify them by specie(s) and clearly identify this on the sample box (or bag) and follow the 
instructions for recording and shipping sea herring samples. 
 
Note: When a species mix is noted the identified species must be broken out and recorded as a 
separate sample with a notation in the COMMENTS field, on the BSMDBS, that the samples 
were gained from the same landing. 
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9.8 Mackerel 


 
 


Species Name MKT NAME NESPP3 MKT CAT Lengths Sexed Scales Otos Freeze Units  Remarks 
MACKEREL, ATLANTIC UNCLASSIFIED 212 0 100 N     25   
MACKEREL, ATLANTIC LARGE 212 1 100 N     100   
MACKEREL, ATLANTIC SMALL 212 2 100 N     25   
MACKEREL, ATLANTIC MEDIUM 212 3 100 N     25   
MACKEREL, ATLANTIC EXTRA LARGE 212 4 100 N     100   


 
A length sample of mackerel consists of 100 randomly selected fish from which a minimum of 
25 fish are taken for aging.  Stratification for selecting fish for aging is as follows: 


 
1.0-cm Interval Number of Fish/1.0-cm Interval 


<35 1 or more 
>35 2 or more 


 
It is very important that an age sample be taken with every length sample (per fish if necessary). 
Fish selected for aging must be packaged with the information required on the Scale Envelope 
using a manila tag or equal substitute.  The fish must be frozen for later processing at: 
 
NOAA Fisheries NEFSC 
166 Water Street 
Woods Hole, MA 02543-1026 
(508) 495-2000 
FAX (508) 495-2258 
 
If the fish are sorted by market category prior to sampling, then a length sample of each market 
category is necessary.  
 
If there is less than the required number of fish for aging per 1.0-cm interval, all fish available in 
that interval are taken.  Indicate on the Length Sample Form the number of fish frozen (“OTO” 
column). 
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9.8.1 Alternate Atlantic Mackerel Age Structure Gathering Protocol 
 
In an effort to better characterize the catch the NEFSC has requested 100 fish be frozen for LRG 
and X-LRG market category samples.  This procedure requires more freezer space and increases 
the size and weight of the packages being shipped to the NEFSC from the Field Offices, to a near 
unacceptable level.   
 
An alternative method of age structure gathering has been developed.  Record the length, on a 
slip of paper (fork length, cm) in pencil (grease or lead), sever the head behind the pectoral fin, 
in a vertical fashion from the dorsal to the ventral surface (see diagram below), put the 
documented length into the mouth and place the head in a plastic bag or create a bag for each 
length interval and place all of the similar frequencies in the appropriate bag with a slip of paper 
noting the length for that bag.  Severing the head in this manner should leave enough tissue for 
the age processors to get a grip on when they remove the otoliths.  After the sample is complete, 
discard or return the headless carcass to the vessel or dealer.  Carefully place the bagged heads or 
frequency bags into a ‘clean’ larger plastic bag, Ziploc is preferred, and squeeze out the air so the 
heads cannot bounce around (this could result in the dislodging of the paper slip) also place a 
copy of the samples header information in the larger ‘clean’ bag.  Freeze your sample and ship it 
to the NEFSC when appropriate. 
 
 
 
 
 


 
 
 
 
 
 
 
 
Note: When a species mix is noted the identified species must be broken out and recorded as a 
separate sample with a notation in the COMMENTS field, on the BSMDBS, that the samples 
were gained from the same landing. 
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9.9 Butterfish 


 
 


Species Name MKT NAME NESPP3 MKT CAT Lengths Sexed Scales Otos Freeze Units  Remarks 
BUTTERFISH LARGE 51 0 100 N     25   
BUTTERFISH UNCLASSIFIED 51 1 100 N     25   
BUTTERFISH JUMBO 51 2 100 N     25   
BUTTERFISH LARGE/MIX 51 3 100 N     25   
BUTTERFISH MEDIUM 51 5 100 N     25   
BUTTERFISH SMALL 51 6 100 N     25   
BUTTERFISH SUPER SMALL 51 7 100 N     25   
BUTTERFISH SUPER SUPER SMALL 51 8 100 N     25   


 
The length sample for butterfish consists of 100 randomly selected fish from which a minimum 
of 25 fish for an age sample are taken according to the following stratification:  


 
1.0-cm Interval Number of Fish/1.0-cm Interval 


<14 2 or more 
>15 3 or more 


 
If there is less than the required number of fish for aging in any 1.0-cm interval, all fish available 
in that interval are taken.  If butterfish are landed unculled and then sorted into market 
categories, the sample of fish must be taken randomly as the fish are off-loaded, prior to culling. 
However, when the fish are culled into size groups at sea, or if sampling in the port occurs after 
the fish are sorted by size, then a sample of each market category must be taken.  Whenever 
possible, sample the fish prior to sorting.  Purchase the sample of fish if necessary. 
 
Fish selected for aging are packaged, labeled with the information required on the Scale 
Envelope, and frozen for later processing at: 
 
NOAA Fisheries NEFSC 
166 Water Street 
Woods Hole, MA 02543-1026 
(508) 495-2000 
FAX (508) 495-2258 
 
If the fishermen are cooperative, try to obtain a random sample of the fish retained at sea, as well 
as a sample of the discard, using white plastic buckets (a half bucket of fish should be more than 
sufficient).  Randomly select 100 fish from each bucket and process them as a regular sample. 
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9.10 Tilefish 


 
 


Species Name MKT NAME NESPP3 MKT CAT Lengths Sexed Scales Otos Freeze Units  Remarks 
TILEFISH, GOLDEN UNCLASSIFIED 446 0 100 N   20     
TILEFISH, GOLDEN LARGE 446 1 100 N   20     
TILEFISH, GOLDEN MEDIUM 446 2 100 N   20     
TILEFISH, GOLDEN SMALL 446 3 100 N   20     
TILEFISH, GOLDEN KITTENS 446 4 100 N   20     
TILEFISH, GOLDEN EXTRA LARGE 446 5 100 N   20     


 
A length sample of tilefish consists of 100 randomly selected fish.  If the fish are sorted by 
market category prior to sampling, then sampling by market category is necessary.  Twenty 
otoliths for aging must be taken for each length sample following the 1.0-cm rule. 
 
Note: When a species mix is noted the identified species must be broken out and recorded as a 
separate sample with a notation in the COMMENTS field, on the BSMDBS, that the samples 
were gained from the same landing. 
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9.11 Red Hake 


 
 


Species Name MKT NAME NESPP3 MKT CAT Lengths Sexed Scales Otos Freeze Units  Remarks 
HAKE, RED UNCLASSIFIED 152 0 100 N         


 
A length sample of red hake consists of 100 randomly selected fish.  If the fish are sorted by 
market category prior to sampling, then sampling by market category is necessary.  Weigh and 
measure by sex if possible.  No age structures are required.   
 
Note: When a species mix is noted the identified species must be broken out and recorded as a 
separate sample with a notation in the COMMENTS field, on the BSMDBS, that the samples 
were gained from the same landing. 
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9.12 White Hake 


 
 


Species Name MKT NAME NESPP3 MKT CAT Lengths Sexed Scales Otos Freeze Units  Remarks 
HAKE, WHITE UNCLASSIFIED 153 0 100 N   25     
HAKE, WHITE SMALL ROUND 153 1 100 N   25     
HAKE, WHITE SMALL GUTTED 153 2 100 N   25     
HAKE, WHITE UNCLASSIFIED 153 3 100 N   25     
HAKE, WHITE LARGE ROUND 153 4 100 N   25     
HAKE, WHITE MEDIUM ROUND 153 5 100 N   25     
HAKE, WHITE LARGE DRAWN 153 6 100 N   25     
HAKE, WHITE MEDIUM DRAWN 153 7 100 N   25     
HAKE, WHITE SMALL DRAWN 153 8 100 N   25     
HAKE, WHITE UNCLASSIFIED 153 9 100 N   25     


 
White hake are one of the more difficult species to sample as they are usually landed without the 
head.  If they are sorted by market category, each market category is considered as a separate 
sample.   
 
The reusable plastic strip is the preferred method (Figure 2-1).  Align the edge of the plastic strip 
at the 0-cm mark on the sampling board.  Place the white hake on the board with the cut end at 0 
or align the anterior insertion of the first dorsal fin with the 0-cm mark.  Total lengths can then 
be marked directly on the strip using a grease pencil or soft carpenter’s pencil.  After completing 
the sample, the marks may be washed off using a household cleaner making the strips reusable.  
If the “Hake Strip’ is not available place follow the above procedure and then multiply your 
lengths by 1.334 to get the corrected length that shall be recorded in the BSM.  It is expected you 
will have a zero value every 3 intervals. 


 


Figure 9-1.  Drawing Depicting the Use of a Plastic Strip  
for Measuring White Hake 


 
 
Note: When a species mix is noted the identified species must be broken out and recorded as a 
separate sample with a notation in the COMMENTS field, on the BSMDBS, that the samples 
were gained from the same landing. 
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9-13 Anglerfish or Monkfish 


 
 


Species Name MKT NAME NESPP3 MKT CAT Lengths Sexed Scales Otos Freeze Units  Remarks 
ANGLER (GOOSEFISH) TAILS, ONLY 12 0 100 N   25   otos: 25 vertebrae 
ANGLER (GOOSEFISH) TAILS, LARGE 12 1 100 N   25   otos: 25 vertebrae 
ANGLER (GOOSEFISH) TAILS, SMALL 12 2 100 N   25   otos: 25 vertebrae 
ANGLER (GOOSEFISH) UNCLASSIFIED 12 4 100 N   25   otos: 25 vertebrae 
ANGLER (GOOSEFISH) PEEWEE 12 6 100 N   25   otos: 25 vertebrae 
ANGLER (GOOSEFISH) GUTTED, WHOLE 12 8 100 N   25   otos: 25 vertebrae 


 
Anglerfish (or Monkfish) is another species usually landed without the head and can also prove 
difficult to measure.  They are usually culled into market categories and each market category is 
treated as an individual sample.  (See Appendix G for sampling area and gear request.). 
 
Anglerfish/Monkfish must be measured from the first Post-cephalic Dorsal Fin Spine to the end 
of the Caudal Fin.  The punch strip works best for measuring anglerfish.  The conversion back to 
total length is performed when the samples are processed at the NOAA Fisheries NEFSC in 
Woods Hole, Massachusetts.  Figure 9-2 should aid in determining the proper measuring 
technique.  The preferred method is to place the caudal fin at zero and determine where the first 
post-cephalic spine meets the body of the fish.  If the skin has separated from the body, lift the 
spine and look under the skin to determine the point of contact.   


 
Figure 9-2.  Diagram of an Anglerfish 


Note: When a species mix is noted the identified species must be broken out and recorded as a 
separate sample with a notation in the COMMENTS field, on the BSMDBS, that the samples 
were gained from the same landing. 
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9-14 Spiny Dogfish 
 
 


 


 
 


Species Name MKT NAME NESPP3 MKT CAT Lengths Sexed Scales Otos Freeze Units  Remarks 
DOGFISH, SPINY DRESSED 352 0 100 Y         
DOGFISH, SPINY ROUND 352 1 100 Y         
DOGFISH, SPINY GUTTED 352 3 100 Y         


 
A Spiny Dogfish length sample consists of 100 fish sorted by sex.  No age structures are 
requested, at this time.  Total lengths are gathered with the caudal fin in the upright ‘natural’ 
state.  Sex determination is performed by viewing the pelvic fin area and checking for claspers 
(see above). 
 
Note: When a species mix is noted the identified species must be broken out and recorded as a 
separate sample with a notation in the COMMENTS field, on the BSMDBS, that the samples 
were gained from the same landing. 
 
 
 
 







 
NERO                                                     Biological Sampling Work Instructions        Rev.0                                        March 2, 2010   


45 


9-15 Winter, Thorny and Barndoor Skate 
 


 
 


Species Name MKT NAME NESPP3 MKT CAT Lengths Sexed Scales Otos Freeze Units  Remarks 
SKATES, WHOLE UNCLASSIFIED 365 0 300         LBS 
SKATES, WINGS UNCLASSIFIED 365 1 300         LBS 


 
Winter, Thorny and Barndoor Skates can be landed either whole or as wings.  Additionally, these 
skates can be either culled or un-culled by species.  Both market categories (whole or wings) 
shall be treated as an individual sample.  A sample consists of 300 lbs. for whole skate and/or 
300 lbs. for skate wings (small samples less than 300 lbs. can be accepted).   
 
Samples must be taken at the following ports, at the following frequency: 
 


Sampling Port Sampling Frequency 
Portland, ME Monthly 


New Bedford, MA Weekly 
Chatham, MA Weekly 


Point Judith, RI Weekly 
Cape May, NJ Monthly 


Other Ports Monthly 
 
In addition to counts and weights, the following trip level data must be collected with all skate 
samples:  
 


• Port, Permit, Vessel Name, Date Sampled, NEGEAR, Total Wing Count 
• Total Sample Weight, SamplerID1, SamplerID2, Counts by Species 
• Weights by Species, Dealer Name, Dealer Number 


 
For recording data on punch strips, the strips should be divided up in to quadrants that are 
correctly labeled with one quadrant per species.  One hole will be used to denote one individual 
wing or whole skate.  The correct weight must be assigned to each species collected on the punch 
strip. 
 
Data collected using the Allegro system must be carefully entered as the only accessible fields 
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are SEX and LENGTH.  To enter data into the Allegro system, species will be assigned to the 
SEX field using 0  = Winter, 1 = Thorny, and 2 = Barndoor as species assignments.  Enter  a 
number from the range 0-2 in the SEX field for correct species.  In the LENGTH field, enter 1 to 
note an individual wing or whole skate.  Assign the correct total weight for each species by then 
entering the species number (0-2) in the SEX field and entering the corresponding weight into 
the LENGTH field. 
 
9.15.1 Procedure for Un-culled Skate Wings 
For unculled skate wing samples, a total count of individual wings must be recorded with the 
total weight of wings in the sample. Additionally, the wings must be sorted by species to record 
the count and weight of wings for individual species.   
 
9.15.2 Procedure for Culled Skate Wings 
Culled skate wings require that the total number and weight of wings in the sample be recorded 
along with the number and weight of individual species.  Additionally, culled wings must be 
checked to determine if the cull is correct.  If not, the un-culled procedure for skate wings must 
be followed.   
 
9.15.3 Procedure for Un-culled Whole Skate 
For unculled skate wing samples, a total count of individual wings must be recorded with the For 
unculled whole skate, a total count of individuals must be recorded with the total weight of skate 
in the sample. Additionally, individuals must be sorted by species to record the count and weight 
for individual species.   
 
9.15.4 Procedure for Culled Whole Skate 
Culled whole skate require that the total number and weight of individuals in the sample be 
recorded along with the number and weight of individual species.  Additionally, culled whole 
skate must be checked to determine if the cull is correct.  If not, the un-culled procedure for 
whole skate must be followed.    
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9.16 Sea Scallop 
 


 
 


Species Name MKT NAME NESPP3 MKT CAT Lengths Sexed Scales Otos Freeze Units  Remarks 
SCALLOP, SEA UNDER 10 800 2 200 N         
SCALLOP, SEA 11-20 CO 800 3 200 N         
SCALLOP, SEA 21-30 CO 800 4 200 N         
SCALLOP, SEA 31-40 CO 800 5 200 N         
SCALLOP, SEA 41-50 CO 800 6 200 N         
SCALLOP. SEA 51-60 CO 800 7 200 N         
SCALLOP, SEA 61+ COUNT 800 8 200 N         
SCALLOP, SEA UNCLASSIFIED 800 9 200 N         


 
To obtain scallop samples, ask the vessel captain if he would place 200 (top valve only) shells 
from the last tow of each trip in a plastic tote or special box provided by the NOAA Fisheries.  
These boxes of shells will be picked up at the end of each trip and measured by the sampler. 
 
A special measuring board or strips are provided for 
measuring scallops, although the standard aluminum 
punch strips and measuring board can be used (see 
Section 1.3).  The method used for measuring 
scallops is shown in Figure 9-3. 
 
 


 
 
 
 
 
 


                                                                Figure 9-3.  Scallop Measurement 
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9.17 Squid 
 


 
 
  


Species Name MKT NAME NESPP3 MKT CAT Lengths Sexed Scales Otos Freeze Units  Remarks 
SQUID (ILLEX) UNCLASSIFIED 802 0 100 N         
SQUID (ILLEX) SMALL ROUND 802 1 100 N         
SQUID (ILLEX) MEDIUM ROUND 802 2 100 N         
SQUID (ILLEX) LARGE RO 802 3 100 N         
SQUID (ILLEX) TUBE UNC 802 4 100 N         
SQUID (ILLEX) TUBE SMALL 802 5 100 N         
SQUID (ILLEX) TUBE MEDIUM 802 6 100 N         
SQUID (ILLEX) TUBE LARGE 802 7 100 N         
SQUID (LOLIGO) UNCLASSIFIED 801 0 100 N         
SQUID (LOLIGO) LARGE 801 1 100 N         
SQUID (LOLIGO) SMALL 801 2 100 N         
SQUID (LOLIGO) MEDIUM 801 3 100 N         
SQUID (LOLIGO) SUPER SMALL 801 4 100 N         
SQUID (LOLIGO) EXTRA LA 801 5 100 N         


             
Squid are separated into species (loligo or illex, Figure 9-
4) and are measured by mantle (body) length.  Each 
species is measured and recorded separately on Length 
Sample Forms (Figure 1-3).  When squid are separated 
into market categories (both species), samples by market 
category are taken and noted on the Length Sample Form. 
 One hundred (100) of each species must be included 
from each sample when both species occur in the landing. 
 The weight of each group measured is recorded on the 
Length Sample Form.  Note separate squid sampling 
requirements in Appendix F for individual port areas.  
 
NOTE:  Industry supplied cull data is widely available 
but should not be considered a substitute     for NEFSC requests. 
 
 


                                                           
                                                                                 Figure 9-4.  Measurement and Identification of Squid 







 
NERO                                                     Biological Sampling Work Instructions        Rev.0                                        March 2, 2010   


49 


9.18 Shrimp 
 


 
 


Species Name MKT NAME NESPP3 MKT CAT Lengths Sexed Scales Otos Freeze Units  Remarks 
SHRIMP (PANDALID) UNCLASSIFIED 736 0   N     1 QT 


 
The fishery for Northern Shrimp (Pandalus borealis) is a seasonal fishery.  During the season, 
weekly sampling of shrimp landings will be conducted in Rockland, Maine; Portland, Maine; 
and Gloucester, Massachusetts and other ports when shrimp landings are significant.  A shrimp 
sample will consist of a 1-quart sample taken from different parts of the catch, preferably the 
first and the last part to be unloaded.  (A scoop fashioned from a plastic 1-quart container with 
the bottom removed works well for this.) 
 
The subsamples must be packaged, labeled, and frozen with the information required on the 
Scale Envelope (Figure 7-2) Because this species is managed under the Northern Shrimp 
Section of the Atlantic States Marine Fisheries Commission, the individual state fisheries 
agencies for Maine, New Hampshire, and Massachusetts process the biological samples of 
shrimp and the federal sampler will have to arrange to get samples to these state agencies. 
 
If the samples must be purchased from the vessel, the sampler will be reimbursed by submitting 
a voucher for payment (NOAA Form 34-6) to the cashier at the NOAA Fisheries Northeast 
Regional Office (NERO). 
 
NOAA Fisheries NERO 
One Blackburn Drive 
Gloucester, MA  01930 
(978) 281-9304 
FAX (978) 281-9333 
 
Complete a Length Sample Form (Figure 6-1) for each sample taken; mark “FROZEN” in red 
across the face of the form, and send the completed form to: 
 
NOAA Fisheries NEFSC 
166 Water Street 
Woods Hole, MA  02543-1026 
(508) 495-2000 
FAX (508) 495-2258 
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9.19 Crab and Lobster 
 


              
 


Species Name MKT NAME NESPP3 MKT CAT Lengths Sexed Scales Otos Freeze Units  Remarks 
CRAB, RED UNCLASSIFIED 710 0 100 Y         
CRAB, UNKNOWN UNCLASSIFIED 713 0 100 Y       identify species 
LOBSTER, AMERICAN UNCLASSIFIED 727 0 100 Y         
LOBSTER, AMERICAN SMALL 727 2 100 Y         
LOBSTER, AMERICAN SELECT 727 3 100 Y         
LOBSTER, AMERICAN LARGE 727 4 100 Y         
LOBSTER, AMERICAN JUMBO 727 5 100 Y         


 
Generally, crabs or lobsters are unloaded into plastic totes or wooden crates.  One hundred (100) 
individuals or a minimum of two containers will be sampled per trip, however, if the large cage-
type containers are used for unloading, the 100 individuals must be measured from one or several 
cages and the lengths recorded on the Length Sample Form (Figure 6-1).   
 
Each sex will be recorded on the Length Sample Form separately.  As with other species, all 
market categories landed will be sampled.  Males and females are recorded separately.  Figures 
9-5, 9-6, and 9-7 can be used for the identification of red, rock, and Jonah crabs, respectively.  
Figure 9-8 shows the method for measuring lobsters.  Differences between the male and female 
Jonah and rock crabs are similar to that shown for the red crab. 
 
A caliper (calibrated in millimeters; the standard used for shellfish) is used for measuring crab 
and lobster.  The Length Sample Form will accommodate millimeter measurements and the 
sampler must note millimeters on the form. 
 
Note: When a species mix is noted the identified species must be broken out and recorded as a 
separate sample with a notation in the COMMENTS field, on the BSMDBS, that the samples 
were gained from the same landing. 
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Figure 9-5.  Measuring and Sexing Red Crabs 
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Figure 9-6.  Diagram of a Rock Crab 
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Figure 9-7.  Diagram of a Jonah Crab 
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Figure 9-8.  Diagram of Lobster Measurement 
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9.20 Surf Clam and Ocean Quahog Sampling 
 


               
 


Species Name MKT NAME NESPP3 MKT CAT Lengths Sexed Scales Otos Freeze Units  Remarks 
CLAM, SURF UNCLASSIFIED 769 0 30 N         
QUAHOG, OCEAN UNCLASSIFIED 754 0 30 N         


 
A surf clam or ocean quahog sample consists of 30 clams, measured to the nearest 1.0 mm as 
shown in Figure 9-9.  Sub-sampling is not required, however the sample must be made up of 30 
clams that have been randomly selected from different cages.  The best method for selecting 
clams to sample is to take six (6) clams from five (5) different cages.  The sampler should retain 
a copy of the sample. 
 
A sampler should attempt to 
interview the vessel captain and 
record the information on the 
Length Sample Form (Figure 6-
2).  At a minimum, the sampler 
should obtain the name of the 
vessel the sample is from, the date 
landed, and the name of the 
dealer.  (A copy of the vessel’s 
logbook for the sampled trip or 
the vessel’s name and number and 
date sailed would be most 
desirable. 
 
 
                                                                         
                                                                         
                                                                                                                         Figure 9-9.  Clam Measurement
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9.21 Discard Samples 
 
Occasionally, a port sampler may be requested to conduct a “discard sample.”  Discard samples 
are defined as samples of fish or shellfish that are discarded by fishermen because they are too 
small or undesirable for the market.  Discard samples are taken to obtain information on year 
class strength and estimates of pre-recruit mortalities.  Discard samples are sorted by species and 
then handled or processed in the same manner as a regular sample with each species being 
recorded separate forms.  Discard is sampled dockside as fish are culled, at sea by a special sea 
sampler, or by asking a vessel captain to save discard for sampling ashore.  To sample discard 
ashore, ask the fishermen to fill special boxes placed aboard their cooperating vessels with fish 
or shellfish they would generally throw overboard after culling at sea.  Discard boxes should be 
placed aboard vessels when logs or interviews indicate that discard of a particular species is 
significant. 
 
Because of the numerous regulations by species concerning the number of fish legally obtained 
on board the vessel as well as legal size limits by species, the sampler should ensure proper 
clearances have been obtained, by or for the vessel, before sampling.  Clearances are obtained 
from the NOAA Fisheries Regional Administrator’s Office for federal waters and the individual 
state fisheries agencies inside state waters. 
 
9.22 Special Samples 
 
At any time, if special samples are requested without specific instructions on how to collect the 
sample, follow the standard procedures for sampling as described in Section 2.0 of this manual, 
and always use the manual’s standard procedures for labeling the sample. 
 
9.23 Industrial Sampling 


 
Samples of fish from industrial landings (fish used for reduction) are used to determine species 
composition.  Occasionally, they are used to determine length and age composition.  Generally, a 
vessel fishing for industrial fish will separate food fish from the catch to sell separately. 
 
Most industrial fish are landed in ports located in New Bedford, Port Judith, and Gloucester, 
Massachusetts.  Industrial fish are sampled from two locations; from the hold before they are 
unloaded and from the conveyor as they are unloaded.  Procedures for sampling from these 
locations are given below. 
 
9.23.1 Procedures for Sampling Industrial Fish 


• Hold Sampling:  When sampling from the hold, two 1-bushel baskets are scooped from 
the catch, each bushel from a different part of the load.  This method is least desirable 
and should not be undertaken unless it is impossible to sample from the conveyor. 


 
• Conveyor Sampling:  A conveyor sample is taken from a chute or conveyor as the fish 


are being pumped out of the hold.  As the fish pass down the chute or conveyor, a scoop 
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of fish is taken every few minutes until the two 1-bushel sub-samples are filled.  
Conveyor sampling is the preferred method of sampling and must be performed 
whenever possible. 


 
• Bushel Sampling:  Each bushel (sub-sample) is processed and the data recorded 


separately.  The fish are sorted into species groups and the individuals are measured.  The 
total weight of each species group is recorded on the Length Sample Form along with the 
number of fish in each group. 


 
9.23.2 Mixed Trips (Industrial) 
Occasionally a captain does not unload industrial fish after each trip but will save the catch from 
several trips before unloading.  Many times these mixed trips are from different grounds and 
have a different species composition.  These trips should not be sampled. 
 
9.23.3 Pure Trip (Industrial) 
A “pure trip” of industrial fish refers to a pure catch.  If the catch of industrial fish is made up of 
one species (95% pure menhaden, pure eelpout, etc.) it must not be sampled.  The species is 
recorded on the weighout as menhaden for reduction, or eelpout for reduction rather than “other 
for reduction.” 
 
9.23.4 Sampling Area and Vessel Requirements for Industrial Sampling 
For each sampling area, a minimum of five samples per month must be taken.  In addition, each 
vessel involved in industrial fishing must be sampled at least once each month.  Each vessel 
fishing industrial fish must be interviewed every time it lands. 
 
 
Note: When a species mix is noted the identified species must be broken out and recorded as a 
separate sample with a notation in the COMMENTS field, on the BSMDBS, that the samples 
were gained from the same landing. 
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10.0 The Port Sample Tally Sheet 
 
The Port Sample Tally Sheet (Figure 10-1), 
if required by the Sampling Coordinator or 
stated in the contractual agreement, should be 
completed bi-weekly.  Elements of the report 
are presented in Table 10-1.   
 
If required, the Port Sample Tally Sheet 
should be delivered to the Sampling 
Coordinator or the Contracting Officer’s 
Technical Representative (COTR) of the 
project. 
 


                                                                                     Figure 10-1.  Port Sample Tally Sheet 
 
 


Table 10.1.  Elements of the Port Sample Tally Sheet 
 
Entry Description 
Sampler ID Sampler name. 
Port Office The Port Office reporting the sample. 
Report Date Period of time the report covers (e.g., January 1 to January 31). 
Number of Samples Number of samples completed in the report. 
Vessel Name The vessel from which the fish were sampled (e.g., F/V Pontos). 
Vessel Permit List the vessel’s 6-digit permit number (e.g., 410154). 
Date Landed The date fish were landed, when known, otherwise date sampled. 
Species Name of fish sampled (e.g., scup, winter flounder, silver hake). 
Market Category Market size (e.g., large, jumbo, pin, kitten). 
Port Landed Port where fish were packed out (e.g., Portland, Chatham, Greenport). 
Area Fished Three-digit statistical area where fish were caught (e.g., 616, 613).  Leave blank if unknown. 
Int or Log If area fished is obtained from interview, list “INT”, if area is not obtained list “LOG” and a 


search of the VTRs will be made to determine the area. 
Gear NOAA Fisheries gear code that identifies gear used to catch sampled fish (e.g., 050). 
Number Lengths Total number of fish measured in a sample. 
Number Ages Total number of age samples taken. 
VTR log# Leave blank.  This may change when dealers report unique trip ID. 
Month Docn. Document number used to enter report with sampled fish into the CODES system.  Often this 


document number is not known at the time of the report.  When the document numbers are 
known resubmit the complete Port Sampling Tally Sheet. 
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11.0 Species Codes (see the BSMDBS) 
12.0 Conversion Factors (see the BSMDBS) 
13.0 Gear Codes (see the BSMDBS) 
14.0  State, Port, and County Codes (see the BSMDBS) 
15.0 Biological Sampling Requirements (see the BSMDBS) 
 
16.0  List of Acronym 
 
BSMDBS  Biological Sample Monitoring Database System 
 
CODES  Commercial Data Entry Subsystem 
 
COTR   Contracting Officer’s Technical Representative 
 
DMR   Department of Marine Resources 
 
eSampling  Electronic Data Sampling 
 
FIS   Fishery Information System 
 
NEFSC   Northeast Fisheries Science Center 
 
NERO   Northeast Regional Office 
 
NOAA   National Oceanic and Atmospheric Administration 
 
NOAA Fisheries National Marine Fisheries Service 
 
VTR   Vessel Trip Report 
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Biological Sample Monitoring (BSM) Web Entry System 
 


1.0. BSM Start Up 


 Access the BSM start up page using the URL below. 


http://nova.wh.whoi.edu/bsmdbs/ 


The click on  “Web-Based Data Entry”  to go to the BSM Start Up screen. 


BSM start up screen:  Click on “Login” on the blue banner.   You must login to proceed.   


 


If you do not have a username and password, click on “Contact” to send an email for support. 
“Contact” can also be used for general request for support as well. 


  



http://nova.wh.whoi.edu/bsmdbs/





 


2.0. BSM Login Screen    


After you click on “Login” on the blue toolbar, the following screen will display.  Enter your 
username and password and click on “Login”.   


Note:   The “Enter” key will not work to execute the login.  The Enter and Tab keys are only 
used to move between columns.    


 


 


After you login successfully, the “Welcome to Biological Monitoring Sampling Web Page” is viewable. 


 


  







3.0      New Sample Entry 


After Login, the user is presented with the screen to “Manage Tallies”.  From the “Manage 
Tallies” screen you may (1) create a new tally; (2) search for an existing tally; or (3) view, edit or 
delete a tally.  See sections 4, 5 and 6 for more details on search, view, edit and deletion of a 
tally, a sample, a header and a length.  


3.1. Create a New Tally 


To create a new tally, click on “Create New Tally” in the upper right corner of the screen under 
Operations. 


 


  







The “Create New Tally” screen is displayed with the current year and “today’s” date.  Change 
the date if necessary and choose a port from the pull-down list by clicking on the small arrow in 
the Tallyport textbox.  Note that all columns with a red star (*) next to them, are required. 


Create New Tally Screen 


 


After the screen is populated with date and port, click on the submit button to save the data and 
move to the next screen to “View” the tally.   


Note:  You must click on “Submit” to proceed to the next screen.  The Enter and Tab keys 
cannot be used to move between screens.   


 


  







From the “View Tally” screen, you may perform the following operations for the current tally: 
(1) Update Tally; (2) Delete Tally; (3) Create New Sample.   
 
View Tally Screen 


 


 


  







3.2.  Add a Sample 


To add a sample to a tally, click on “Create New Sample” under the Operations menu. The 
“Create New Sample” screen will be displayed.  The Tallyno should be visible in its textbox on 
this screen. 


 Enter the data requested on the screen, and click “Submit” to save the data and proceed to the 
“View Sample” screen.  Fields with a red star (*) are required. 


Create New Sample Screen 


 


 


 


  







From the “View Sample” screen, you may perform the following operations for the current 
sample: (1) Update Sample; (2) Delete Sample; (3) Create Length Header.    Click on “Create 
Length Header” to create a new header for this sample. 
 
View Sample Screen 


 


 


  







3.3.  Create a Length Header 


Enter the data requested on the screen, and click “Submit” to save the data and proceed to the 
“View Length Header” screen. 


Create Length Header Information Screen 


 


From the “View Length Header” screen, you may perform the following operations for the 
current sample: (1) Update Length Header; (2) Delete Length Header; (3) Create Length Detail 
Record.    Click on “Create Length Detail Record” to enter the lengths for this sample. 
 
View Length Header Screen 


 


Enter the data requested on the screen, and click “Submit” to save the data and proceed to the 
“View Length Detail” screen.   


Create Length Detail Screen 







 


 


From the “View Length Header and Length Detail” screen, you may perform the following 
operations for the current sample: (1) Update Length Header; (2) Delete Length Header; (3) 
Create Length Detail Record.   You may also Edit or Delete an individual length record by using 
the  symbols next to each length row.   If you hover the mouse over the symbol it will 
indicates its function.  The magnifying glass is View, the pencil is Edit, and the red X is Delete.    


 
 
View Length Header and Length Detail Screen 







 


 


3.4.   How to Add Additional Sample Information  


To Add a Length to an Existing Sample 


To add an additional length to length detail, from the “View Length Detail” screen, choose 
“Create Length Detail”.  All of the lengths/number at length entered previously will be opened.  
Go to the next empty cell to add another length.  Click on submit to view the lengths. 


  







To Add another Sample Header for a Sexed Sample 


If a sample is sexed, and the second sex is added by returning to the Sample View; Click on  
“Create Length Header” to enter the info for the next sex code;  Submit;  at the next screen, click 
on “Create Length Detail Record’ to enter the length details for the second sex. 


Home > Tally Manage > Tally View > Sample View > Length Header View 
 


To Add a New Species/Market to an Existing Tallyno 


To add another sample to this Tallyno, click on the breadcrumb for “Tally View” at the top of 
the View Length Detail screen and return to the View Tally screen.  If you are elsewhere in the 
system,  you can always go back to the “Manage Tallies” screen and click on the  magnifying 
glass icon at the end of the tally row to view the tally and proceed from this point to add an 
additional sample. 


From the “View Tally” screen click on “Create New Sample” enter the data for an additional 
sample under the same Tallyno.  Repeat all of the steps in Section 3.2 above for completing the 
sample entry.  


Home > Tally Manage > Tally View > Sample View > Length Header View 
 


  







4.0 Search and Edit 


4.1.  Return to “Manage Tally” Screen 


Return to the “Manage Tallies” screen.  This may be done two ways, (1) by clicking on “Tally” 
in the blue tool bar at the top of each screen; or (2) by clicking on the “Tally Manage” 
breadcrumb just below the tool bar. 


(1) by clicking on “Tally” in the blue tool bar at the top of each screen 


 


(2) by clicking on the “Tally Manage” breadcrumb just below the tool bar from any screen. 
This is an example 


        Home > Tally Manage > Tally View > Sample View > Length Header View 
 


4.2.  Search for a Tally 


If the Tallyno to be edited is not visible, search for it using the ‘Advance Search” feature or by 
typing the number in the blank box just below the column headers and press Enter.  See sample 
results search for Tallyno 13205 below. 


 


  







Following is an example of an advanced search to find all Tallyno in 2013 with KATIE as the 
first name.  Queries using character strings are case sensitive. 
 


 


 


4.3   View, Edit or Delete a Tally 


Using the symbols next to the tallyno row,  , choose the magnifying glass to view a 
tally, the pencil to edit and the red X to delete the tally. 


  







Sample Tally View With One Sample 


 


To update the Tally, click on “Update Tally” under the Operations menu to go to the “Update 
Tally screen. 


 


Make the changes and then click on “Submit” to save the changes.  You will be returned to the 
“View Tally” screen to see the revised Tally.   


  







Update Tally Screen 


 


To delete a Tally, click on the red X next to the Tallyno row, .  A popup box will 
appear to allow you to cancel or OK the tally delete.  Remember that if you delete a Tallyno, all 
of the samples associated with that Tally will be deleted as well.   


Delete Tally Screen 


 


 


  







5.0.   View, Edit, or Delete:  Sample, Length Header, and Length Detail Records 
 
5.1.   View and Edit a Sample 
 
Drill down from the Tally View to the “View Sample” Screen.  From the “View Sample” screen, 
click on “Update Sample”.  The “Update Sample” screen will open. 
 
View Sample Screen 


 


  







Update Sample Screen 


Make the necessary changes, then click on “Submit” to save and return to the “View Sample” 
screen. Note that some columns are grayed out and cannot be edited from this screen.   


Update Sample Screen 


 


 


  







Delete a Sample Option 


 


A popup box will appear to allow you to cancel or OK the sample delete. 


Delete a Sample Feedback 


  







5.2.   View, Edit or Delete a Length Header Record 


Drill down from the “Tally View” screen to the “View Length Header” you want to edit.   See 
Section 4.3 for instructions on how to view a Tally.  Click on “Update Length Header” to open 
the “Update Length Header” screen.  Make the changes, click on “Submit” to return to the “View 
Length Header” screen. 
 
View Length Header screen 


 
 
Update Length Header screen 


 
 
5.3.  View, Edit or Delete a Length Detail Record 
 
From the “View Length Header” ,go to the bottom of the screen to  the “Length Detail” view list.  
Click on the “Pencil” icon next to the length record to be edited.  The “Update Length” screen 







will open.  Make the changes, click on Submit to return to the “View Length Detail” screen to 
see the changes. 
 
Length Detail View 


 
 
 Update Length Screen 


 
 
 
  







View Length Detail Screen 


 
 
 Delete Length Record 
 
To delete a length record, click on the red X next to the length record.  A popup box will appear 
to allow you to cancel or OK the length delete. 
 


 
 
 
  







6.0  Contacts 
 
NAME ROLE TELEPHONE EMAIL 
Stephen Link Sampling Coordinato 757-771-0614 Stephen.Link@noaa.gov 
Patricia 
Hersey   


Application Developer 508-495-2313 Patricia.Hersey@noaa.gov 


Joan Palmer Co-Project Manager 508-495-2247 Joan.Palmer@noaa.gov 
Greg Power Co-Project Manager 978-281-9304 Greg.Power@noaa.gov 
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I. Sampling Data Quality Review 


All scripts can be found on the NE Port Biological Sampling Program wiki page 


(https://www.st.nmfs.noaa.gov/confluence/display/PBSP/NE+Port+Biological+Sampling


+Program) under Program Management/Quality management/Scripts. 


A. Use the BSMDBS Audit SQL script to compile sampling data from the Biological 


Sample Monitoring Database System (BSMDBS) data tables and copy and paste 


into an excel spreadsheet. 


B. Add a column for staff type and fill in as appropriate (FTE, Contract). 


C. Use the various excel features to check for potential data issues.  Indicate what the 


potential issue is in the ISSUE 1 or ISSUE 2 column.  If more than two issues are 


found for a single row of data, add additional issue columns.  Any observations that 


may help resolve the issue should be added to the ADDITIONAL COMMENTS 


column. 


1. Potential issues include: 


a) Duplicate DOCNs: Repeated DOCNs within the same month 


b) Duplicate samples: Samples with the same PERMIT, NESPP4, and 


DATELAND 


c) Incorrect species: Species that are not typically sampled or invalid 


NESPP4 codes 


d) Incorrect market: NESPP4 does not match to a valid market  


e) No sampler information 


f) Samples with the same VTRSERNO, but different vessels 


g) Mismatched permit: The PERMIT entered does not match with 


VESSELNAME entered 


h) Missing area: No AREA information entered 


i) Missing VTRSERNO: No VTRSERNO information entered (exception 


hagfish from state vessels) 


j) Missing AREA and VTRSERNO: no area or VTRSERNO information 


entered 



https://www.st.nmfs.noaa.gov/confluence/display/PBSP/NE+Port+Biological+Sampling+Program

https://www.st.nmfs.noaa.gov/confluence/display/PBSP/NE+Port+Biological+Sampling+Program
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k) Incorrect VTRSERNO: VTRSERNO does not fit typical VTRSERNO format 


(e.g. number of digits) 


l) Missing REGION: no region information entered 


m) Incorrect GEAR: invalid gear code entered 


n) Missing WEIGHT: no weight information entered (where applicable) 


2. Use the conditional formatting function to highlight duplicates (one column at 


a time) in the YEARMONTHDOCN, NESPP4VTRSENO, NESPP4PERMIT 


DATELAND, and VTRSERNO columns to check for duplicate DOCNs, duplicate 


samples, samples with the same VTRSERNO, but different vessels, and 


mismatched permits. 


3. Use the filter feature (one column at a time) on the SPPNM, MKTNM, AREA, 


VTRSERNO, GEARNM, WT, REGION, and SAMP1 columns to look for missing 


or potentially incorrect information (where applicable) in these columns. 


D. After all issues have been identified, create pivot tables to summarize the number 


of issues by issue type and staff type. 


1. Create a table for each ISSUE column. 


a) Row labels: ISSUE, STAFF 


b) Values: Count DOCN 


2. Combine all of the tables to get the total number of each issue. 


E. Create a spreadsheet of the identified issues for each staff type. 


1. Each issue type should be in a separate tab within each spreadsheet. 


2. Include a summary tab with the issue totals (from D above) for the indicated 


staff type.   


3. Verify that the number of rows in each tab matches the summary totals. 


F. Post the finished spreadsheets to the Data Quality Review Results page of the NE 


Port Biological Sampling Program Wiki page 


(https://www.st.nmfs.noaa.gov/confluence/pages/viewpageattachments.action?pag


eId=43287659). 


G. Issues will be forwarded to appropriate staff for correction or comment as follows: 



https://www.st.nmfs.noaa.gov/confluence/pages/viewpageattachments.action?pageId=43287659

https://www.st.nmfs.noaa.gov/confluence/pages/viewpageattachments.action?pageId=43287659
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1. FTE:  Create a JIRA in the NEPBSP project with FTE spreadsheet created in E 


above attached for each staff member that has more than one issue identified.   


Add the Section Manager and COR as watchers. 


2. Contractor: COR will create a JIRA in the NEPBSP project to forward issues to 


the contractor. 


 


II. Samples Requested, Collected and Landings Data Comparison 


All scripts can be found on the NE Port Biological Sampling Program wiki page 


(https://www.st.nmfs.noaa.gov/confluence/display/PBSP/NE+Port+Biological+Sampling


+Program) under Program Management/Quality management/Scripts. 


A. Use the Requests, Samples, Landings merge spreadsheet to compile samples 


requested, samples collected, and landings data for a specified sampling quarter. 


1. Use the current sampling requests to determine the number of samples, 


lengths, and ages requested.   


a) Copy and paste above information into the Data tab of the Requests, 


Samples, Landings merge spreadsheet. 


b) Delete rows where # SAMPLES Requested is zero. 


2. Compile sampling data from using the Sample Data SQL script.  


a) Specify the year and quarter in the upper portion of the script, create the 


table, and run the section of the script that assigns the appropriate 


REGIONs, AREA_REQs, and GEAR_REQs to the data. 


Before running this section, verify that the correct GEAR_REQ 


update for mackerel is used (it varies by quarter). 


b) Check the updated table for null values in the NESPP4_GRP and 


GEAR_REQ fields and AREA_REQ equal to AREA_REQ.  Manually add the 


necessary information to the table and save the finalized data to a 


spreadsheet for future reference. 


c) Run the last section of the script to total the samples by all requested 


categories and copy and paste the results into the Data tab of the 


Requests, Samples, Landings merge spreadsheet. 



https://www.st.nmfs.noaa.gov/confluence/display/PBSP/NE+Port+Biological+Sampling+Program

https://www.st.nmfs.noaa.gov/confluence/display/PBSP/NE+Port+Biological+Sampling+Program
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d) Download and save the current Anticipated Area spreadsheet from the 


Google drive.  Use it to add skate sample information to the data tab of 


the Requests, Samples, Landings merge spreadsheet. 


3. Compile landings data. 


a) Use the Clams SQL script to gather surf clam and ocean quahog landings 


data. 


(1) Specify the time period in the upper section of the script where it 


says A.Cd between…, create the table, and run the section of the 


script that assigns the appropriate NESPP3, NESPP4, NESPP4_GRP, 


SPECIES, REGION, AREA_REQ, and GEAR_REQ to the data. 


(2) Check the updated table for AREA_REQ equal to AREA_REQ.  


Manually add the necessary information to the table and save the 


data in a spreadsheet for future calculations. 


(3) Run the second to last portion of the script to total the landings by 


all requested categories and copy and paste the information into the 


Data tab of the Requests, Samples, Landings merge spreadsheet. 


(4) Run the last section of the script to total the landings by species and 


market category and copy and paste the results into the Data tab of 


the Requests, Samples, Landings merge spreadsheet. 


b) Use the Landings Data SQL script to gather the other requested species’ 


landings data from the CFDERS tables. 


(1) Specify the year, months, and NESPP4s of the requested species and 


markets in the upper section of the script, create the table, and run 


the section of the script that assigns the appropriate REGION, 


AREA_REQ, and GEAR_REQ to the data. 


Before running this section, verify that the correct GEAR_REQ 


update for mackerel is used (it varies by quarter). 


(2) Check the updated table for AREA_REQ that equal AREA_REQ.  


Manually add the necessary information to the table and save the 


data in to same spreadsheet as the clam landing data (3 a 2 above). 


(3) Run the second to last portion of the script to total the landings by 


all requested categories and copy and paste the information into the 


Data tab of the Requests, Samples, Landings merge spreadsheet. 
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(4) Run the last section of the script to total the landings by species and 


market category and copy and paste the results into the data tab of 


the Requests, Samples, Landings merge spreadsheet. 


4. Use the compiled data to create the following pivot tables in the appropriate 


tabs of the Requests, Samples, Landings merge spreadsheet. 


a) Overall Species and Market Request 


(1) Row labels: NESPP4_GRP, SPECIES, MARKET 


(2) Values: Sum of # SAMPLES Requested, Sum of # LENGTHS 


Requested, Sum of # AGES Requested,  Sum of # SAMPS Collected, 


Sum of # LENGTHS Collected, Sum of # AGES Collected, Sum of TOT 


WEIGHT Sampled, Sum of TOTAL LBS REPORTED, Sum of TOTAL # 


REPORTS, Sum of ALL TOTAL LBS REPORTED, Sum of ALL TOTAL # 


REPORTS 


(3) Copy and paste the results into the Overall Compare tab of the 


Request, Samples, Landings Compare spreadsheet. 


b) Full Request 


(1) Row Labels:  NESPP4_GRP, SPECIES, MARKET, REGION, AREA, 


GEAR 


(2) Values: Sum of # SAMPLES Requested, Sum of # LENGTHS 


Requested, Sum of # AGES Requested, Sum of # SAMPS Collected, 


Sum of # LENGTHS Collected, Sum of # AGES Collected, Sum of TOT 


WEIGHT Sampled, Sum of TOTAL LBS REPORTED, Sum of TOTAL # 


REPORTS 


(3) Copy and paste the results into Full Request Compare tab of the 


Request vs. Samples –All Compare spreadsheet. 


B. Calculate the percentages of requests filled 


1. Overall Comparison 


a) Calculate the percentage of requested lengths and ages collected by 


dividing the number collected by the number requested in the % 


LENGTHS Filled and % AGES Filled columns respectively. 
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(1) Filter for values of #DIV/0! and decide if they should be changed to 


N/A (no ages are requested) or if the row should be deleted (no 


request was made; exception: samples were collected). 


(2) If the columns are not already formatted, format them so that they 


are percentages, values less than 50% are bold and red, and values 


greater than 100% are blue and bold. 


b) Add a grand total row at the bottom of the spreadsheet. 


c) Highlight rows with no possession species or rows where no request was 


made, but sample(s) were taken. 


2. Full Request Comparison 


a) Calculate the percentage of requested lengths and ages collected by 


dividing the number collected by the number requested in the % 


LENGTHS Filled and % AGES Filled columns respectively. 


(1) Filter for values of #DIV/0! and decide if they should be changed to 


N/A (no ages are requested) or if the row should be deleted (no 


request was made; exception samples were collected). 


(2) If the columns are not already formatted, format them so that they 


are percentages, values less than 50% are bold and red, and values 


greater than 100% are blue and bold. 


b) Complete the LENS over/under column by subtracting the number of 


lengths requested from the number of lengths collected. 


(1) If the column is not already formatted, format it so the any values 


less than 0 are bold and orange 


c) Fill in the %SPP MKT Request Filled column with data from the 


corresponding species and market % LENGTHS Filled column in the 


Overall Compare tab. 


d) Add a grand total row at the bottom of the spreadsheet.  


e) Highlight rows with no possession species or rows where no request was 


made, but sample(s) were taken. 


C. Identify Significant Landings 


1. By Vessel 
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a) Using the Landings Data spreadsheet created above in A 3, create a pivot 


table to total the landings by PERMIT and DEALNUM 


(1) Row labels: SPPNM, MKT_REQ, REGION, AREA_REQ, GEAR_REQ, 


PERMIT, DEALNUM, ST, PORTNM 


(2) Values: Sum of LB, Sum of # RPTS 


b) Copy and paste the values only of the results next to the table. 


c) Add a LB/#RPTS column to calculate the average weight of landings per 


report by dividing the number of pounds reported by the number of 


reports 


d) Sort the data by SPECIES, MKT_REQ, and LBS/# RPTS. 


e) Use the average weight of a typical sample (see Appendix A for how to 


calculate) to highlight the rows as follows 


(1) No area, &/or LBS/ # RPTS less than estimated sample weight 


(2) 1-5 reports and LBS/ # RPTS approximately equal to or greater 


than estimated sample weight 


(3) 6-29 reports & LBs/ # RPTS approximately equal to or greater than 


estimated sample weight 


(4) 30 or more reports & LBS/ # RPTS approximately equal to or 


greater than estimated sample weight 


f) Copy and paste the data into the Significant Landings tab of the Request 


vs. Samples –All Compare spreadsheet and delete the rows that fall into 


category 1 from 1 e above. 


2. By Dealer  


a) Using the significant landings by vessel data, create a pivot table next to 


the data with the below criteria. 


(1) Row labels: SPPNM, MKT_REQ, REGION, AREA_REQ, GEAR_REQ, 


DEALNUM, ST, PORT 


(2) Values: Sum of LB, Sum of # RPTS 


b) Copy and paste values only of the pivot table results next to pivot table 


and delete the original pivot table. 
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c) Highlight rows according to below criteria 


(1) 1-5 reports  


(2) 6-29 reports  


(3) 30 or more reports  


D. VTR Landings and Associated Graphs 


1. Use the VTR Landings SQL script to compile VTR landings data for the 


specified time period. 


a) Specify the time period and the VTR species codes for the requested 


species in the upper section of the script.  Create the table and run the 


section of the script that assigns the appropriate SPECIES, STOCK AREA, 


GEAR, and REGION information to the data. 


b) Copy and pasted the results into the VTR Landings tab of the Request vs. 


Samples –All compare spreadsheet. 


2. Use the Clam VTR Landings SQL script to compile the surf clam and ocean 


quahog landings data. 


a) Specify the time period in the upper section of the script, create the table, 


and run the section of the script that assigns the appropriate SPECIES, 


STOCK AREA, GEAR, and REGION information to the data. 


b) Copy and paste the results into the VTR Landings tab of the Request vs. 


Samples –All compare spreadsheet.  


3. Used the compiled data to create the following pivot charts  


a) Landings by species and gear 


(1) Chart specifications 


(a) Axis fields: SPPNM 


(b) Legend Fields: GEAR GRP 


(c) Values: sum of LB 


(2) Change chart type to 3-D Columns 


(3) Add Chart titles, axis titles, and other necessary text boxes 
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b) Landings by species, stock area, and gear 


(1) Chart specifications 


(a) Axis fields: SPPNM, STOCK ABBR 


(b) Legend Fields: GEAR GRP 


(c) Values: sum of LB 


(2) Change the chart type to 3-D Columns. 


(3) Add Chart titles, axis titles, and other necessary text boxes. 


E. Post the finished spreadsheet to the Sampling Request- Samples- Landings 


Compare page of the NE Port Biological Sampling Program Wiki page 


(https://www.st.nmfs.noaa.gov/confluence/pages/viewpageattachments.action?pag


eId=42501529&metadataLink=true).  


III. Sampling Review Progress Report 


A. Create summaries of sampling related JIRAs.  


1. NE Port Biological Sampling Program (NESPBSP) 


a) Use the Issue Statistics JIRA gadget and the 2012 NEPBSP and the 2013 


NESPBSP filters (Appendix B) to update the totals in the top table in the 


NEPBSP JIRAs tab of the Sampling Program Review Progress Report 


spreadsheet. 


b) Update the number of Currently Open/ In Progress JIRAs at the top of the 


tab. 


c) Use the Created vs. Resolved Chart JIRA gadget and the 2013 NESPBSP 


filter to update the 2013 JIRAs table. 


(1) Maximize the gadget and edit the table if necessary to include all 


days of the current year. 


(2) Add the necessary week(s) and the corresponding numbers of 


created and resolved JIRAs to the 2013 JIRAs table. 


(3) Verify that the totals match the numbers in the top JIRA table. 



https://www.st.nmfs.noaa.gov/confluence/pages/viewpageattachments.action?pageId=42501529&metadataLink=true

https://www.st.nmfs.noaa.gov/confluence/pages/viewpageattachments.action?pageId=42501529&metadataLink=true
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d) Copy and paste the results of the Two Dimensional Filter Statistics: 2013 


NEPBSP (+ active 2012) (Appendix B) JIRA gadget into the 2013 JIRA 


Status table. 


2. NER Compliance (NERC) 


a) Update the number of Currently Open/ In Progress JIRAs at the top of the 


tab using the Issues Statistics JIRA gadget and the Samp NERC filter 


(Appendix B). 


b) Add the necessary week(s) and the corresponding numbers of Moved 


and Resolved JIRAs to the ALL NERC table. 


c) Copy and paste the results of the Two Dimensional Filter Statistics: Samp 


NERC JIRA gadget into the 2013 JIRA Status table. 


B. BSMDBS Review 


1. Update the time period at the top of the BSMDBS Audits tab of the Sampling 


Review Program Progress Report spreadsheet. 


2.  Copy and paste the summary table of potential issues broken down by staff 


type from the most recent BSMDBS Audit Spreadsheet. 


3. Create a summary table of potential issues without staff type. 


C. Samples Requested vs. Collected 


1. Each sampling quarter will have its own tab in the Sampling Review Program 


Progress Report spreadsheet. 


a) Sampling quarters in progress: Copy and paste the number of LENGTHS 


REQUESTED, AGES REQUESTED, LENGTHS COLLECTED, AGES 


COLLECTED, % LENGTHS Filled and % AGES Filled from the Overall 


Compare tab of the most recent Request, Samples, Landings Compare 


spreadsheet into a tab for that quarter.  


b) Completed sampling quarters: If not already done, update completed 


quarters’ tabs using the final Request, Samples, Landings Compare 


spreadsheet for that quarter. 


D. Post the finished spreadsheet to the Program Progress Reports page of the NE Port 


Biological Sampling Program Wiki page 


(https://www.st.nmfs.noaa.gov/confluence/pages/viewpageattachments.action?pag


eId=42501523&metadataLink=true). 



https://www.st.nmfs.noaa.gov/confluence/pages/viewpageattachments.action?pageId=42501523&metadataLink=true

https://www.st.nmfs.noaa.gov/confluence/pages/viewpageattachments.action?pageId=42501523&metadataLink=true
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Appendix A: Calculating Average Weight of Samples 


1) Use the Ave WT SQL script from the NE Port Biological Sampling Program wiki page 


(https://www.st.nmfs.noaa.gov/confluence/display/PBSP/NE+Port+Biological+Sampli


ng+Program) under Program Management/Quality management/Scripts.at script) to 


pull 2009 and later sampling data for samples with the required amount of lengths +/- 


10 and sample weight >0. 


a) If no samples meet these criteria for a given species and market category, use data 


from previous years. 


b) If no samples have the required number of lengths +/-10, use the existing data to 


estimate a per fish weight and extrapolate the weight of a full sample.   


2) Species not requiring a weight 


a) Scallops - use 500 LBS  


b) Skates- use 300 LBS 


c) Surf clams and Ocean Quahogs- no landings should be excluded based on weight 


since the landings numbers are in bushels.    


  



https://www.st.nmfs.noaa.gov/confluence/display/PBSP/NE+Port+Biological+Sampling+Program

https://www.st.nmfs.noaa.gov/confluence/display/PBSP/NE+Port+Biological+Sampling+Program
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Appendix B: JIRA Filters 


2012 NEPBSP: 


project = "NE Port Biological Sampling Program" AND type != Task AND created < 


"2013/01/01" 


2013 NEPBSP: 


project = NEPBSP AND created > "2013/01/01" AND type != task  


2013 NEPBSP (+active 2012):  


project = NEPBSP AND (created > "2013/01/01" OR status in (Open, "In Progress", 


Reopened)) AND type != task 


Samp NERC*: 


project = "NER Compliance" AND created >= "2012/11/08" AND (reporter = 


"Aaron.Dieckerhoff" OR reporter = "alissa.wilson" OR reporter = "jodie.york" OR 


reporter = "joshua.o'connor@noaa.gov" OR reporter = "katie.almeida" OR reporter = 


"Marc.Renaghan" OR reporter = "sara.petrochic@noaa.gov" or reporter = 


"Robert.Bollmann") AND key >= NERC-309 


* Change or add reporter names as necessary 








Sample Targetting Process 
June 18, 2013


Find landings that are available to 
sample (Hail Lines, Tele Contacts, In 
Person Visits, Team Members, etc..) 


Are the landings from 
federally permitted vessels 


with VTR reporting 
requirements?


Do Not 
Gather.


NO


Do we currently have 
targets that meet the 


Region, Species, Gear, 
MKT CAT?


YES


Is the species a unit stock?


YES


Are we in a volume 
period with relaxed 


protocols?
NO


Gather the data needed 
for the Biological Sample.


Are there current targets 
for the specific stock?


Determine the 
Statistical Area 


Fished using Vtracks, 
VMS Email, 


Interview, etc.


NO NO


NO


Refer to the 
‘Relaxed’ Protocol 
to determine needs 


and availability.


YES


Does the sample fit 
within the Relaxed 


Protocol with needed 
targets?


YES


NO


Document your results on the AA 
Document, in your monthly 


samples list and load data to the 
BSMDBS.


Is this a hagfish sample?


No


YES


YES
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Sample Data on the 
BSMDBS


Extract Data 
that needs 
updating


Review 
Derived 


Data


NERO Apps
FVTR Site
VESLOG


Is it a 
‘TRIP or 


DAY’ 
vessel?


Is there an exact 
DATELAND match?


NO


Is it a single or 
multipage VTR?


SINGLE


Is the sampled 
species on more 


than 1 page?


MULTI


NO


Use the listed VTR’s to 
determine AREA based 


on the protocol in the 
Sampling Work 


Instructions.  Use the 
lowest VTR SER# for 


documentation 
purposes.


YES


Is the species 
listed on the 


VTR?


Review the VTR for 
DATELAND, 


SPECIES, Convert 
LAT/LON to CAREA, 


etc.


YES


Document all required data on 
the BSMDBS, Age Packets and 


Sampling List.


Is there a 
reasonable 


dateland match 
present?


Is the sample > 
30 days old?


NO


NO


Create a JIRA, self 
assigned and make 


contact with the vessel, 
document per protocol


YES


YES


NO


DAY Vessel:
DATELAND should match but verify 


the next VTR and Dealer Data.


TRIP Vessel:
DATELAND may be 1-2 days off 


from date sampled. Review following 
VTR and Dealer data to verify trip 


and document per protocol.


YES


Sample Update Process 
June 18, 2013
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Guidelines for Samplers on Missing or Inaccurate 
Vessel Trip Reports 


A. Missing Vessel Trip Reports: 


1) Samplers will contact the vessel to obtain required information from the missing vessel trip 
report: 


a) Samplers, upon discovery of a missing VTR related to a sample they have collected, will 
create a JIRA message in Fish Harmony.  The JIRA will be assigned to the sampler and 
will document the missing VTR error.  Samplers will then initiate contact with the vessel. 


b) The JIRA summary should read as follows: “Sampling Identified VTR Issue – 
PERMIT_VESSELNAME”.   


c) No watchers or other JIRA enhancements are necessary at this step in the process, but the 
issue should be well documented in the event further action is necessary. 


d) If the contact is successful and the VTR information is obtained then no further action is 
necessary and the sampler will close the JIRA issue.   


2) Immediately upon a second failed attempt to obtain the missing VTR information: 


a) Samplers will reassign the JIRA to the IDI team vessel lead, Stefanie Dukes. 


b) Watchers will be added to the JIRA message as follows: 


i) For Contractor samplers:  Steve Link, Katie Almeida, Greg Power, Anthony 
Conigliari, and Victor Vecchio will be added as watchers. 


ii) For Federal samplers: Greg Power, the appropriate Team Coordinator, and Victor 
Vecchio will be added as watchers. 


c) Details of the samplers attempt to obtain the missing VTR information will be added to 
the comments. 


d) Samplers should review progress on the issue and update or add comment as necessary.  
If the missing VTR is provided then the sampler will close the JIRA.  If after fourteen 
days the missing VTR is not provided then the JIRA message will be reassigned to Victor 
Vecchio. 


Note: the intent here is for project management to use the JIRA for tracking these issues 
and determining the validity of the sample in question (e.g., proper for billing), at which 
point a decision will be made concerning closing the JIRA.  Therefore as much 
information as necessary to document the issue must be provided. 


B. Vessel Trip Reports with Missing Species Catch Information: 
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1) Samplers will contact the vessel to verify that the species item(s) in question were actually 
part of the vessel’s trip: 


a) Samplers, upon discovery that a species they have sampled is missing from the 
corresponding VTR will create a JIRA message in Fish Harmony.  The JIRA will be 
assigned to the sampler and will document the missing species information.  Samplers 
will then initiate contact with the vessel. 


b) The JIRA summary should read as follows:  “Sampling Identified VTR Issue – 
PERMIT_VESSELNAME”. 


c) If the vessel confirms that the species item(s) were landed as part of the trip then the 
sampler will assign the JIRA issue to the VTR group lead, Bethany Brosnan. 


d) The JIRA assigned to the VTR group lead should provide the VTR serial number, 
species, quantity, and dealer permit information requesting that the missing information 
be added to the vessel trip report database. 


e) Watchers will be added as follows: 


i) For Contractor samplers:  Steve Link, Katie Almeida, Greg Power, Anthony 
Conigliari, and Victor Vecchio will be added as watchers. 


ii) For Federal samplers:  Greg Power, the appropriate Team Coordinator, and Victor 
Vecchio will be added as watchers. 


f) Samplers should review progress on the issue and update or add comment as necessary.  
If the missing information is added to the VTR database then the sampler will close the 
JIRA.  If, after fourteen days, the missing information is not added to the database, or if 
the vessel refuses to confirm that the species item(s) were a part of their landings then the 
JIRA message will be reassigned to Victor Vecchio. 


Note:  the intent here is for project management to use the JIRA for tracking these issues 
and determining the validity of the sample in question (e.g., proper for billing), at which 
point a decision will be made concerning closing the JIRA.  Therefore as much 
information as necessary to document the issue must be provided. 


 








Greg Power
Program Manager


Victor Vecchio
COR


Steve Link
Contract Program


Manager


Caleb Gilbert
Port Agent


Gloucester MA


Ingo Fleming
Port Agent


Cape May NJ


Steve Ellis
Port Agent


Hampton Va


George Mattingly
Port Agent


Hampton VA


Sara Petrochic
Program Assistance


Katie Almeida
Project Lead


Jodie York
Sampler


Portland ME


Robert Bollmann
Sampler


Gloucester MA


Aaron Dieckerhoff
Sampler


Point Judith RI


Marc Renaghan
Sampler


East Hampton NY


Josh O’Connor
Sampler


Toms River NJ


Alissa Wilson
Sampler


Cape May NJ


NMFS-NE Port Biological Sampling Program
6/20/2013


NMFS/NORTHEAST REGIONAL OFFICE NMFS/NORTHEAST FISHERIES SCIENCE CENTER


Susan Wiley
READ/PDB Point of Contact


Eric Robillard
FEMAD/PBB  Point of Contact


Joan Palmer
DMS  Point of Contact


Joshua Moser
Data Manager





		Page-1�






LIST OF DOCUMENTS FOR DOCKSIDE BIOLOGICAL SAMPLING PROGRAM 


CORE READING  


1. Northeast Regional Office Fisheries Statistics Office Biological Sampling Manual  
This document is a high level manual for collection of dockside biological samples and 
provides the basic instructions or procedures for collecting and coding biological sampling 
information in preparation for data entry. (Source document: h:\\JWITZIG\NEFSC Data 
Review\Documents\FDSD-PBSP Biological Sampling Manual.pdf) 
 


SUPPLEMENTAL READING  


 
2. Biological Sampling Work Instructions  


This manual contains detailed work instructions for conducting biological sampling at ports 
within the Northeast Region of the National Oceanic and Atmospheric Administration 
(NOAA) National Marine Fisheries Service (Fisheries). This manual contains the standards to 
be followed by all Port Agents and NOAA Fisheries Contractors engaged in biological 
sampling at the port level, the authorities and instructions for data collection, and detailed 
descriptions of sampling by species. (Source document: h:\\JWITZIG\NEFSC Data 
Review\Documents\FDSD-PBSP Biological Sampling Work Instructions.pdf) 
 


3. Biological Sample Monitoring (BSM) Web Entry System  User’s Guide  


Instruction manual for the entry of biological sample information. (Source document: 


h:\\JWITZIG\NEFSC Data Review\Documents\FDSD-PBSP BSM Manual-Web-Entry-V1 web 2.pdf) 


 


4. Sampling Program Review Manual  


Detailed outline and instructions for quality audits of biological samples and associated 


documentation. (Source document: h:\\JWITZIG\NEFSC Data Review\Documents\FDSD-PBSP 


Data Review Manual 06-10-13.pdf) 


 


5. Sample Targeting Process  


Flow chart illustrating decision process for sample collection determination.  (Source 


document: h:\\JWITZIG\NEFSC Data Review\Documents\FDSD-PBSP Sample Targetting Process 


2013 06 18.pdf) 


 


6. Sample Updating Process 


Flow chart illustrating decision process for reviewing and updating sample meta data. 


(Source document: h:\\JWITZIG\NEFSC Data Review\Documents\FDSD-PBSP Sample Updating 


Process 2013 06 18.pdf) 


  







 


7. Guidelines for Samplers on Missing or Inaccurate Vessel Trip Reports  


Detailed outline and instructions for correcting information on completed biological 


samples and associated documentation. (Source document: h:\\JWITZIG\NEFSC Data 


Review\Documents\FDSD-PBSP Guidelines for Samplers on missing or errors in VTR's 2012 11 


09.pdf) 


 


8. Dockside Sampling Team Organization Chart  (Source document: h:\\JWITZIG\NEFSC Data 


Review\Documents\FDSD-PBSP Org 2013 03 28.pdf) 


 


9. FY2013 NEFSC Biosamples request (separate EXCEL file) 


Annual request from NEFSC to NERO for sampling for FY 2013. (Source document: 


h:\\JWITZIG\NEFSC Data 


Review\Documents\FY13_Biosamples_final_revised_12102012_withFG_01292013.xlsx) 


 



FDSD-PBSP%20Org%202013%2003%2028.pdf

25.%20FY13_Biosamples_final_revised_12102012_withFG_01292013.xlsx



